
What does ClickBook do?                                                            

ClickBook prints files, documents, or web pages from any Windows application:

¨ As Double or single sided.

¨ As Books of any size.

¨ As brochures or leaflets.

¨ As greeting cards.

¨ As CD Jewel Cases.

¨ As Day Planners.

Top Uses for ClickBook:

¨ Print double-sided without a duplexing printer.

¨ You could fit a large spreadsheet on one page with several pages on each sheet of paper.

¨ Combine your documents, web pages, and other files into 1 print job.

¨ Print an address book to fit in your day planner, purse, wallet, etc.

¨ Create your own list of songs and artists and print it in a CD Jewel Case.

¨ Design Greeting Cards or print electronic greeting cards received.

¨ Clip coupons and make a coupon book.

¨ Gather your own collection of recipes.

¨ Sales & Marketing Managers use ClickBook to print media, product information, press kits, news, etc.

¨ Educators print handouts, assignments, lessons, ebooks, etc.

About printing books

Printing books requires a special arrangement of the pages.    ClickBook takes care of this, giving you instructions each step of the 
way so that the back sides are printed correctly relative to the front sides, and so that after you cut and assemble the book, the 
pages come out in the right order.

ClickBook has over 40 layouts to choose from, and you can create your own so the variety is endless.    The layouts that come with 
ClickBook enable you to print books with the following characteristics.

¨ Sizes from full-sheet down to credit card size.

¨ Suited for folding and stapling, or for cutting and binding by any method.

¨ Two “binding orientations”: for binding in the left margin (and turning pages in the standard way) or in the top margin (and 
flipping pages up).

¨ Pages of book oriented either as portrait or as landscape.



How ClickBook works                                                                           

ClickBook takes the output of your application program’s print command – exactly what would print if you were not using 
ClickBook – and shrinks and rearranges the pages to fit the layout you choose.

ClickBook does not change any formatting done by the application program.    Each page is preserved exactly as the application 
sent it, including margins, page numbering, headers/footers, and all paragraph formatting – everything.

ClickBook formats your document in some or all of the following ways, depending on the printout layout you select and any 
modifications you may make to it:

¨ Shrinking to fit several pages (“mini-pages”) on one sheet of paper, or to fit an oversized page on the desired paper size.

¨ Arranging the mini-pages so that they come out in numerical order after cutting and assembling.

¨ Printing double sided.

¨ Adding ClickBook margins.

¨ Adding extra space for binding.



 Printing a booklet  

1. Open the document in it’s application program.

2. Print the document to a ClickBook printer.    (Use the “Print Using ClickBook” command, if available.)

3. When ClickBook pops up, select a layout.

4. Click ClickBook’s Print button.    (Skip to step 8 now if you’re using a duplexing printer.)

5. When the first-side print job is completely finished, remove the printout stack carefully.    Treat the sheets as though they’re 
glued together – do not rearrange them.

6. Without lifting it off the stack, read the instruction sheet (with the big arrow).    It tells you whether to put the paper in face up 
or face down, and which end of the paper goes in first.    Following the instructions, reinsert the printout stack into the paper 
tray.

7. In ClickBook, click the Print Second Side button.

8. When the second-side print job is completed, retrieve the printout and remove the instruction sheet.

9. Assemble the booklet, according to its layout.

Voila!



Printing your first booklet                                                          

The ClickBook printing process typically begins in your application program.    You prepare your document as usual, and then you 
give the print command.    Set options as you wish in the print dialog box, and then click OK.    This launches ClickBook.    You 
select a layout, optionally change other settings, and then give ClickBook’s Print command.

Step-by-step instructions

We recommend that the very first time that you print from ClickBook, you use the example document we’ve provided, because 
it’s completely formatted and ready to be printed as a booklet.    For instructions on printing the example document, click… 
Printing the example book.

If you prefer to print your own document, click… Printing any document .

To use a duplexing printer, click… Printing a booklet on a duplexing printer .

For an overview, skipping the details, click… Quick summary: Printing a booklet .



Note for Windows 2000 users                                       

At this time, ClickBook Version 5 under Windows 2000 cannot accomplish the following tasks:

*    Insert a blank page.

*    Create a Table of Contents.

*    Accept multiple documents into one print job.

*    Demonstrate a print preview of the document chosen.

*    Read or save print jobs as .cb files.. ClickBook Version 5 under Windows 2000 cannot read the same 

        files as ClickBook Version 5 under another type of Windows. ClickBook Version 5 under Windows

        2000 can only open and print .cb2 files.



Printing the readme.rtf    file                                                      

Note: If your printer has duplexing capability, see also… Printing on a duplexing printer 

1. Make sure your printer is on-line and ready to print with 8.5” x 11” paper.

2. In Explorer or File Manager, open the file readme.rtf from the ClickBook directory.      (\clickbook is the default name for this 
directory, but you may have chosen a different name during installation.)    This will launch your word processor.

          Note:    Many programs have files called readme.rtf. Be sure to open the one from the ClickBook directory!

3. Choose a ClickBook printer, as follows:

a. From the File menu, choose Print.

b. In the Print dialog, choose your ClickBook printer. 

                Note:    If you don’t have any ClickBook printers, see… Installing another printer in ClickBook .

If you’re unsure about the printer you’ve selected, look at the “Name” or “Type”.    For ClickBook printers, this name 
begins with “CB” or “ClickBook”.

c. Click OK to close the Print dialog.

4. ClickBook pops up.

Notice that the “side-by-side (folded)“ layout is already selected.    (It’s shown in the print preview, and also it is displayed 
next to its name in the layout box, below the print preview.)    That’s because we have already printed readme with that layout. 
ClickBook remembers the layout last used for each document.    So for this step, you don’t need to do anything except take 
your first look at ClickBook.    Do take some time to explore…

Get an idea of what all the layouts look like by clicking on the layout box dropdown menu and scroll up and down.    Take a 
minute to play with this feature.

Make sure that when you’re done, the “Side-by-side (folded)” layout is again selected.

5. Click the Print button.    The first side will begin to print.

6. When the last sheet of paper has printed, remove the printout stack carefully, without rearranging the sheets.

Cautionary Tips

· Be careful not to pick up any extra print jobs together with this one.

· If you’re printing on a shared network printer, it may put out a separator sheet between print jobs.    Discard any such 
extraneous sheets.

Make sure you have taken only the intended document and its instruction sheet – with the large arrow.    Then read the 
instruction sheet – without lifting it off the other sheets.

7. Place the printout back into the printer according to the instruction sheet.

If you’re printing on a shared network printer that prints a separator sheet before each print job, place a blank sheet on top of 
the printout stack.

8. Click the Print Second Side button to begin printing the second side.

9. When printing is completed, remove the printout.    Discard extraneous sheets, if any, and set aside the instruction sheet, but 
do not rearrange the rest of the printout stack in any way.



Check the printout.    If the backs and fronts aren’t printed correctly relative to each other, run Custom Printer Setup.

10. Fold the book in half, and staple.



Printing on a duplexing printer                                   

In duplex mode

The instructions below tell how to print any document with ClickBook on a duplexing printer (one that handles double-sided 
printing automatically) You must first set up your printer for ClickBook, if you haven’t done so already. 

Note: These instructions include all of the steps necessary for printing small books, the most complicated kind of booklet.    The 
layout you’re using may be simpler.    Skip the steps for cutting and assembling a book, and/or binding, if these do not apply.

1. Make sure your printer is on-line and ready to print.

2.          a.          Open the document in its application program.

b. Enlarge the fonts if you wish. 

      3.        Send the document to ClickBook. 

4. ClickBook pops up. 

      5.          Select a layout. ( You can get an idea of what all the layouts look like by clicking on the layout box dropdown 

                menu and scroll up and down.)

You only need to select a layout the first time you print a given document with ClickBook.    Thereafter, the program 
remembers which layout was used for that document.    Of course, you can select another layout for it any time you want to 
print the document differently.

6. The Print Preview screen demonstrates what the printed sheets will look like.    This helps you check, for

                example, whether margin sizes are satisfactory, and how many blank pages will print at the end of your book.

7. If you’re printing a layout that will require the cutting the printout, you may wish to print the instructions for cutting and 
assembling.    If so, click on the options button and select Print assembly instructions.    Click OK.

8. Click the Print button.    The booklet will begin to print.

    9.          When the last sheet of paper has printed, remove the printout stack carefully, without rearranging the sheets. 

              Discard any extraneous sheets (such as separator sheets on a shared network printer).    If there is a sheet with

              cutting and assembling instructions, set this aside.    Do not rearrange the rest of the printout stack in any way.

 Check the printout.    If the backs and fronts aren’t printed correctly relative to each other, run Custom Printer 

            setup. 

10.        If you chose a layout requiring cutting and assembling, follow the instructions.    If you turned on the option to print 

            these, they are printed at the end of the print job.

11.  If you chose a folded layout, fold it accordingly.

12.  When printing is completed, remove the printout.    Discard extraneous sheets, if any, and set aside the instruction 

                  sheet, but do not rearrange the rest of the printout stack in any way.

 

 Check the printout.    If the backs and fronts aren’t printed correctly relative to each other, run Custom Printer Setup.

13.  If you choose a layout requiring cutting the paper more than once, follow the cutting and assembly instructions.    If 

                  you turned them on, they are printed on the other side of the instructions for reinserting the paper.    Also, a copy of 

                  them is included in the ClickBook package.



14.  If you printed with a folded layout, fold it.

15. Bind your booklet according to the booklet style of the layout.

In manual duplex mode

If you want to use the printer in manual duplex mode, which requires reinserting the paper stack manually for a double-sided 
printout, ClickBook allows this, and even helps you out with an instruction sheet.    Just turn on ClickBook’s Manual duplex option. 
On the menu bar click on file and select ClickBook Printer Setup.    Once the ClickBook Printer Setup window appears click on 
Printer Settings then select Manual duplexing.    Click OK, and close again.    If the back side doesn’t print correctly relative to the 
front, run Custom Printer Setup, and then print again.



Preparing a document in its application        
Prepare your document as you usually do, but keep in mind that ClickBook will usually shrink the pages.    (ClickBook will scale 
them down unless the layout is full-sized or uses the No scaling setting.)

If you plan to use a layout that shrinks the pages considerable, enlarge your fonts accordingly.    They should be large enough to 
be readable at the mini-page size. 

Normally, no other special preparation is needed for printing with ClickBook.    But in some cases you may want to adjust the 
document in the following ways:

· Use a different font that may scale better.    We recommend True Type fonts, which are fully scalable.

· When printing a multi-document booklet, modify or add headers/footers that are appropriate for the booklet.    In particular, 
you may want to adjust page numbering to be continuous throughout the whole booklet.    See… Headers/footers for a 
multi-document booklet.

· Turn off right justification of text if the right edge came out uneven on the printout. 

· Adjust the margins (or set margins in ClickBook).

· Select No scaling and then set everything at exactly the size you want it to print.    This includes setting fonts at desired sizes, 
and setting the page size to be equal to the mini-page size in the intended ClickBook layout ClickBook usually assures that the 
pages fit the mini-pages, but with scaling off, this is your responsibility. 



Saving a booklet as a file                                                              

To save a print job as a .cb2 file just follow these steps:

1. Press the Save button  on the tool bar. 

Or

1. Click File on the menu options then click on Save or Save As

Before saving, make sure you’ve deleted or undeleted documents as desired.    Any documents marked as deleted when you 
save will not be included in the file.    Tip: If you want to print similar booklets containing different subsets of a group of 
documents, save the whole group as a .cb2 file.    Then, whenever you want to print, open the file and temporarily delete 
undesired documents.

Note: The .cb2 file contains the contents of the documents, not just the file names.    So, if you edit any of the documents after 
saving the .cb2 file, these changes are not reflected in the .cb2 file.



The ClickBook Window                                                                          

ClickBook’s main window is divided into five separate parts: the Menu bar , the Toolbar , the Print Job bar , the Status bar , and 
the Print Preview window .



Menu Bar  

The Menu Bar offers access to commands organized into menus. 

Click on the graphic below to learn more.



File menu  

The File menu deals specifically with ClickBook .cb2 files and printer setup.    A .cb2 is a saved ClickBook print job.

Click on the graphic below to learn more.



 Layouts menu  

From the Layouts menu you are able to set and modify the default layouts for the entire ClickBook program.

Click on the graphic below to learns more about each option.

 



 View menu  

The View menu is used to customize the interface and tools of ClickBook.

Click on the graphic below to learn more about each option.

 



 Tools menu  

The Tools menu is used to access the default options and the temporary print job settings.

Click on the graphic below to learn more about each option.



 Help menu  

The Help menu is used to for information about ClickBook. 

Click on the graphic below to learn about each option.



 InstantX            

The Help menu is used to for information about ClickBook. 

Click on the graphic below to learn about each option.



Toolbar Options  

The ClickBook Toolbar offers one click access to frequently used commands. 

Click on the Toolbars below to learn the function of each button.

Click individual buttons for a description of the action launched by each button.

          Open

          Save 

          Print 

          Options 

          Temporary Settings 

          Insert Blank Page 

          Help 



Print Jobs Bar  

The Print Status feature gives information that applies to the current print job, such as: which printer the print job is going to, how 
many pages it received from the application program, what print jobs are ready to print,    and allows you to delete unwanted print 
jobs.

To find out more click on the graphic below.



The Print Preview Screen                                                            

The Print Preview screen shows the user how the layout for the print job will look once it is printed.

This screen also has the options to Print, Number of copies,    Front and Back views and Sheet Selection.



Sheet Selection   

Sheet Selection allows the user the to print just the front, back or both pages of a document.    Sheet Selection also gives the 
user the option of what page to start printing from and what page to end on.    Users can also select whether they want the 
Instruction Sheet printed also.



 The Status Bar   

By passing the cursor over the screen the Status Bar informs the user what each item is used for does .



Standalone and printing modes                              

Printing mode

When you have sent a document to print through ClickBook, or opened a booklet (.cb2) file, ClickBook is in “printing mode”.    
From printing mode you can print the document, modify or create layouts, change various ClickBook settings – everything except 
set up a printer, which you must do from standalone mode.

Standalone mode

When you start ClickBook without sending a document to print through it, this is “standalone mode”.    From stand alone mode 
you can run Printer Setup (to set up a printer for use with ClickBook), create or modify layouts, change various ClickBook 
settings – everything except print, since there isn’t yet anything to print.    Of course, you can also open a .cb2 file – which puts 
ClickBook in Printing mode.

For more details, see… Ways to start ClickBook 



Ways to start ClickBook                                                          

Here are various ways to start ClickBook in either standalone mode or printing mode.    (These aren’t the only ways, but they 
should be sufficient.)

Standalone mode

Start ClickBook from the Start menu’s program list.

Printing mode

· Open your document in its application program by using the document’s filename from the start menu, the Explorer, or the 
My Computer window (or in any other way).    Then print the document to ClickBook.

· From the Explorer or My Computer, drag the drag the document’s icon to a ClickBook printer’s shortcut on the desktop.

· If the desired ClickBook printer does not have a shortcut on the desktop, open the printer’s window from the Control Panel 
or My Computer.    Then, from the Explorer or My Computer, drag the documents icon to the ClickBook printer icon.

· Open a .cb2 file from the Start menu, the Explorer or My Computer,    This starts ClickBook and loads the booklet in 
preparation for printing.

· Open ClickBook in standalone mode.    Then open a .cb2 file from the File menu and click Open.



  The Layouts Options 

There are two drop down menus in the Layout options.    The one on the left lets the user choose the category of layout they 
want to use.

The second drop down menu shows the what the layout is and the name of the layout.



Printing any document                                                    

Click here to skip the details à Quick summary .

The instructions below tell how to print any document with ClickBook.    If you select a layout with small mini-pages, you may 
wish to enlarge the document’s fonts in your application program.

Notes:

· These instructions include all the steps necessary for printing double-sided small books, the most complicated kind of 
booklet.    The layout you’re using may be simpler.    Skip the steps for double-sided printing, cutting and assembling a 
book, and/or binding, if these do not apply.

· If your printer has duplexing capability, see instead… Printing on a duplexing printer .

1. Make sure your printer is on-line and ready to print.

2.          a.      Open the document in its application program.

b. Enlarge the fonts if you wish.

3. Print the document to ClickBook. 

4. ClickBook pops up. 

Select a layout.    ( You can get an idea of what all the layouts look like by clicking on the layout box dropdown menu and 
scroll up and down.)

You only need to select a layout the first time you print a given document with ClickBook.    Thereafter, the program 
remembers which layout was used for that document.    Of course, you can select another layout for it any time you want to 
print the document differently.

5. The Print Preview screen demonstrates what the printed sheets will look like.    This helps you check, for

                example, whether margin sizes are satisfactory, and how many blank pages will print at the end of your book.

6. If you’re printing a layout that will require the cutting the printout, you may wish to print the instructions for cutting 

                and assembling.    If so, click on the options button and select Print assembly instructions.    Click OK.

7. Click the Print button.    The first side will begin to print.    (if you chose a single-sided layout, skip to step 12.)

      8.          When the last sheet of paper has printed, remove the printout stack carefully, without rearranging the sheets. 

                Discard any extraneous sheets (such as separator sheets on a shared network printer) but leave the instruction 

                sheet    -- with the large arrow – as part of the printout.    Then read the instruction sheet – without lifting it off the 

                other sheets.    Place the printout back into the printer according to its directions.

    9.          Then, if this printer prints an extraneous sheet before each print job, place a blank sheet on top of the printout 

                Stack.

10.     Click the Print Second Side button to begin printing the opposite side.

11.     When printing is completed, remove the printout.    Discard extraneous sheets, if any, and set aside the instruction 

                    sheet, but do not rearrange the rest of the printout stack in any way.

 

 Check the printout.    If the backs and fronts aren’t printed correctly relative to each other, run Custom Printer 

 Setup.



12.  If you choose a layout requiring cutting the paper more than once, follow the cutting and assembly instructions.    If 

                  you turned them on, they are printed on the other side of the instructions for reinserting the paper.    Also, a copy of 

                  them is included in the ClickBook package.

13.  If you printed with a folded layout, fold it accordingly

14. Bind your booklet according to the booklet style of the layout.



Insert Header                                                          

Print Headers, Footers, and Watermarks (text)

This new feature allows you to add a line of text to the top, bottom and/or diagonal position of each mini-page.    You 
can select a separate font, color and size for each type.    We have also provided 4 buttons that will insert the print 
job name, date, time and page number into the header, footer, and/or watermark.

Job – <job> inserts the name of the first job listed in the Print Job bar
Date – <date> inserts the current date the job was printed using this format “month dd, yyyy”
Time – <time> inserts the current time the job was printed using this format “hh:mm AM/PM”
Page –    <#> inserts the current mini-page number

The fonts are scaled to match the mini-page they are used on; for example a 36 point font would be scaled down by 
a factor of 4 when used on a mini-page that is 4 times smaller than a regular sheet of paper.    This makes it easy to 
set up a header, footer, or watermark that can be used for different booklet types as the text will be automatically 
sized for each booklet.

Headers



To place a Header on your current print job follow these steps: 

1.          Click the Options button on the toolbar.    This will bring up the Options dialog box.

2.          Select the Headers, Footers, and Watermarks tab.

3.          In order to print a header a check must be placed next to the Print Headers, Footers,    & Watermarks
                field.
                Note:    Header, Footers, and Watermarks can be permanently shut off by un-checking the “Print 
                Headers, Footers, & Watermarks ” checkbox.

4.          From the drop down menu select Header.

5.          Type your message in the text field box and/or select any of the following buttons:
                Job: places the title of the first print job listed in the Print Job window.
                Date: Places today’s date.
                Time: Places the current time.
                Page: Places the page Numbers.
  
6.          To change the look and feel of the Header click the Select Font button. The Font window will open
                and from here the Font, Font Style, Size, Effects, Color, and Script can all be changed.    The Sample 
                window will demonstrate how the changes will appear.

7.          The Text justification allows you to choose where the Header will be placed: right, left, or center. 
                Place a mark next to the desired position.

8.          The Start printing Headers, Footers, and Watermarks on page option allows you to choose which page 
                the Headers, Footers, and Watermarks will begin.
                Note:    This feature allows you to start the process of printing Headers, Footers, and Watermarks on 
                the mini-page of your choice.    This is useful for when you have a cover page and you don’t want the 
                page number to be printed on that page.    Please note that the page numbering will start on the page 
                you choose.    For example if you start on page 3 it will be numbered as 1, page 4 will be 2 and so on.

9.          The Stop printing Headers, Footers, and Watermarks on page option allows you to choose which page 
                the Headers Footers, and Watermarks will end.
                Note: The default setting of 0 will end the printing of Headers, Footers, and Watermarks on the last 
                page.

10. Click Apply Changes to view any modifications you have made to your headers, footers, or
                watermarks.    The changes will appear in the print preview window.    If the changes are acceptable
                Click OK. Headers will now be placed on your print job.

11.      To temporarily turn on or off these features, for the current print job only, go to the Temporary Job 
                Setting dialog and check or uncheck the “Print Headers, Footers, & Watermarks ” checkbox.



Insert Footer                                                            

Print Headers, Footers, and Watermarks (text)

This new feature allows you to add a line of text to the top, bottom and/or diagonal position of each mini-page.    You 
can select a separate font, color and size for each type.    We have also provided 4 buttons that will insert the print 
job name, date, time and page number into the header, footer, and/or watermark.

Job – <job> inserts the name of the first job listed in the Print Job bar
Date – <date> inserts the current date the job was printed using this format “month dd, yyyy”
Time – <time> inserts the current time the job was printed using this format “hh:mm AM/PM”
Page –    <#> inserts the current mini-page number

The fonts are scaled to match the mini-page they are used on; for example a 36 point font would be scaled down by 
a factor of 4 when used on a mini-page that is 4 times smaller than a regular sheet of paper.    This makes it easy to 
set up a header, footer, or watermark that can be used for different booklet types as the text will be automatically 
sized for each booklet.

Footers



To place a Footer on your current print job follow these steps: 

1.          Click on the Options button on the toolbar.    This will bring up the Options dialog box.

2.          Select the Headers, Footers, and Watermarks tab.

3.          In order to print a header a check must be placed next to the Print Headers, Footers,    & Watermarks
                field.
                Note:    Header, Footers, and Watermarks can be permanently shut off by un-checking the “Print 
                Headers, Footers, & Watermarks ” checkbox.

4.          From the drop down menu select Footer.

5.          Type your message in the text field box and/or select any of the following buttons:
                Job: places the title of the first print job listed in the Print Job window.
                Date: Places today’s date.
                Time: Places the current time.
                Page: Places the page Numbers.

6.          To change the look and feel of the Footer click the Select Font button. The Font window will open
                and from here the Font, Font Style, Size, Effects, Color, and Script can all be changed.    The Sample 
                window will demonstrate how the changes will appear.

7.          The Text justification allows you to choose where the Footer will be placed: right, left, or center. 
                Place a mark next to the desired position.

8.          The Start printing Headers, Footers, and Watermarks on page option allows you to choose which page 
                the Headers, Footers, and Watermarks will begin.
                Note:    This feature allows you to start the process of printing Headers, Footers, and Watermarks on 
                the mini-page of your choice.    This is useful for when you have a cover page and you don’t want the 
                page number to be printed on that page.    Please note that the page numbering will start on the page 
                you choose.    For example if you start on page 3 it will be numbered as 1, page 4 will be 2 and so on.

9.          The Stop printing Headers, Footers, and Watermarks on page option allows you to choose which page 
                the Headers Footers, and Watermarks will end.
                Note: The default setting of 0 will end the printing of Headers, Footers, and Watermarks on the last 
                page.

10.      Click Apply Changes to view any modifications you have made to your headers, footers, or
                watermarks.    The changes will appear in the print preview window.    If the changes are acceptable
                Click OK. Headers will now be placed on your print job.

11.        To temporarily turn on or off these features, for the current print job only, go to the Temporary Job 
                  Setting dialog and check or uncheck the “Print Headers, Footers, & Watermarks ” checkbox.



Insert Watermark                                              

Print Headers, Footers, and Watermarks (text)

This new feature allows you to add a line of text to the top, bottom and/or diagonal position of each mini-page.    You 
can select a separate font, color and size for each type.    We have also provided 4 buttons that will insert the print 
job name, date, time and page number into the header, footer, and/or watermark.

Job – <job> inserts the name of the first job listed in the Print Job bar
Date – <date> inserts the current date the job was printed using this format “month dd, yyyy”
Time – <time> inserts the current time the job was printed using this format “hh:mm AM/PM”
Page –    <#> inserts the current mini-page number

The fonts are scaled to match the mini-page they are used on; for example a 36 point font would be scaled down by 
a factor of 4 when used on a mini-page that is 4 times smaller than a regular sheet of paper.    This makes it easy to 
set up a header, footer, or watermark that can be used for different booklet types as the text will be automatically 
sized for each booklet.

Watermarks



This new feature allows you to insert a graphic watermark, such as a company logo, into the center of each mini-
page. ClickBook uses a point for point system for sizing the graphic and will allow you to scale the watermark from 
10 times its original size to 1/10 its original size.    For example a 600 by 600 pixel graphic would be 1 inch on a 
mini-page using a 600 dpi (dots per inch) printer. To make the graphic 2 ½ inches or 2 ½ times bigger enter 2.5 in 
the edit box below the Graphic button. 
Note: Watermark graphics must be in bitmap format.

Please note that the graphic colors will not be changed in any way and will appear the same way it does in your 
graphic editor.    You may want to lighten up the graphic before using it as a watermark so the text in front of it does 
not get washed out.    You can do this with most graphic editors and word processors.    The readme.doc explains how 
to do this using MS Word in the section titled “How do I lighten up my watermark graphics in MS Word?” listed in 
Troubleshooting.

To place a Watermark on your current print job follow these steps: 

1.          Click on the Options button on the toolbar.    This will bring up the Options dialog box.

2.          Select the Headers, Footers, and Watermarks tab.

3.          In order to print a header a check must be placed next to the Print Headers, Footers,    & Watermarks
                field. 
                Note:    Header, Footers, and Watermarks can be permanently shut off by un-checking the “Print 
                Headers, Footers, & Watermarks ” checkbox.

4.          From the drop down menu select Watermark.

5.          Now place a mark next to Text or Graphic depending on which is desired for the Watermark.

6a.      If Text has been chosen you may now decide what information is to be placed in the Watermark. 
                Options include placing the following:
                Job: places the title of the first print job listed in the Print Job window.
                Date: Places today’s date.
                Time: Places the current time.
                Page: Places the page Numbers.
                Whatever you type in the textbox.

6b.      To change the look and feel of the Watermark click the Select Font button. The Font window will 
                open and from here the Font, Font Style, Size, Effects, Color, and Script can all be changed.    The 
                Sample window will demonstrate how the changes will appear.

7.          If Graphic has been chosen you can browse to the location of the image and select it or type the 
                location of the image in the text field. 

8.          The Scale watermark graphic times the original size field allows you to make the image larger or 
                smaller as desired.
 
9.          The Start printing Headers, Footers, and Watermarks on page option allows you to choose which page 
                the Headers, Footers, and Watermarks will begin. 
                Note:    This feature allows you to start the process of printing Headers, Footers, and Watermarks on 
                the mini-page of your choice.    This is useful for when you have a cover page and you don’t want the 
                page number to be printed on that page.    Please note that the page numbering will start on the page 
                you choose.    For example if you start on page 3 it will be numbered as 1, page 4 will be 2 and so on. 

10.      The Stop printing Headers, Footers, and Watermarks on page option allows you to choose which 



                page the Headers Footers, and Watermarks will end.
                Note: The default setting of 0 will end the printing of Headers, Footers, and Watermarks on the last 
                page.

11. Click Apply Changes to view any modifications you have made to your headers, footers, or
                watermarks.    The changes will appear in the print preview window.    If the changes are acceptable
                Click OK. Headers will now be placed on your print job.

12.      To temporarily turn on or off these features, for the current print job only, go to the Temporary Job 
                Setting dialog and check or uncheck the “Print Headers, Footers, & Watermarks ” checkbox.



How to use the Layout Wizard                                      

To use the Layout Wizard

Open the Layout Wizard.

· On the Menu Bar select layouts and click on the Layout Wizard.

Make the changes you want and click on Next.

If, at any time, you want to quit the Layout Wizard click Cancel.

Layout Wizard – Step 1 allows the user to select a layout similar to the one they would like to use.

_______________

See also…

Layout Wizard Step 2 

Layout Wizard Step 3 

Layout Wizard Step 4 

Layout Wizard Step 5 

Layout Wizard Step 6 

Layout Wizard Step 7 

Modify Layout 



Layout Wizard Step 2  

Make the changes you want and click on Next.

If you don’t like a change you make on the last step, click Back

If, at any time, you want to quit the Layout Wizard click Cancel.

Layout Wizard – Step 2 allows the user to select style of booklet they want.

_______________

See also…

Layout Wizard Step 1 

Layout Wizard Step 3 

Layout Wizard Step 4 

Layout Wizard Step 5 

Layout Wizard Step 6 

Layout Wizard Step 7 

Modify Layout 



Layout Wizard Step 3  

Make the changes you want and click on Next.

If you don’t like a change you make on the last step, click Back

If, at any time, you want to quit the Layout Wizard click Cancel.

Layout Wizard - Step 3 allows the user to select the size of paper and how they want the binding.

_______________

See also…

Layout Wizard Step 1 

Layout Wizard Step 2 

Layout Wizard Step 4 

Layout Wizard Step 5 

Layout Wizard Step 6 

Layout Wizard Step 7 

Modify Layout 



Layout Wizard Step 4  

Make the changes you want and click on Next.

If you don’t like a change you make on the last step, click Back

If, at any time, you want to quit the Layout Wizard click Cancel.

Layout Wizard – Step 4 allows the user to select whether they want Sub Booklets and change scaling.

_______________

See also…

Layout Wizard Step 1 

Layout Wizard Step 2 

Layout Wizard Step 3 

Layout Wizard Step 5 

Layout Wizard Step 6 

Layout Wizard Step 7 

Modify Layout 



Layout Wizard Step 5  

Make the changes you want and click on Next.

If you don’t like a change you make on the last step, click Back

If, at any time, you want to quit the Layout Wizard click Cancel.

Layout Wizard – Step 5 allows the user to change the margins.

_______________

See also…

Layout Wizard Step 1 

Layout Wizard Step 2 

Layout Wizard Step 3 

Layout Wizard Step 4 

Layout Wizard Step 6 

Layout Wizard Step 7 

Modify Layout 



Layout Wizard Step 6  

Make the changes you want and click on Next.

If you don’t like a change you make on the last step, click Back

If, at any time, you want to quit the Layout Wizard click Cancel.

Layout Wizard – Step 6 allows the user to select an icon to use with this layout.

_______________

See also…

Layout Wizard Step 1 

Layout Wizard Step 2 

Layout Wizard Step 3 

Layout Wizard Step 4 

Layout Wizard Step 5 

Layout Wizard Step 7 

Modify Layout 



Layout Wizard Step 7  

Make the changes you want and click on Next.

If you don’t like a change you make on the last step, click Back

If, at any time, you want to quit the Layout Wizard click Cancel.

Layout Wizard – Step 7 informs you how to save all of your changes in the Modify Layout dialog, which appears once you have 
clicked finish.

_______________

See also…

Layout Wizard Step 1 

Layout Wizard Step 2 

Layout Wizard Step 3 

Layout Wizard Step 4 

Layout Wizard Step 5 

Layout Wizard Step 6 

Modify Layout 



Modify Layout dialog box                                                            

The Modify Layout dialog box allows the user to make permanent changes to any layout format.    It also allows the user to save 
their changes as a new layout by selecting Save As or to save their changes over an existing layout by clicking done.

_______________

See also…

Layout Wizard Step 1 

Layout Wizard Step 2 

Layout Wizard Step 3 

Layout Wizard Step 4 

Layout Wizard Step 5 

Layout Wizard Step 6 

Layout Wizard Step 7 



ClickBook Printer Setup                                                                  

 You have already installed ClickBook and now wish to install an additional (or a first) ClickBook printer.    Note: You don’t need 
another driver.    A Windows printer driver for the printer, and ClickBook, are all you need.

Follow these steps:

1. First, make sure that the printer is installed in your Windows system.

2. In standalone mode, go to ClickBook Printer Setup which is found in the File menu.

· Click the Windows Start button to display the Start Menu.

· On the Start Menu, go to Programs, Blue Squirrel, ClickBook.

· In ClickBook Select the file Menu, Click on ClickBook Printer Setup.

3. Choose your printer model from the Printer to Set Up list.

4. Click Easy Printer Setup

5. Make sure the correct printer is highlighted, and click OK.

If your printer is not on the list, click Cancel.    Then run Custom Printer Setup.

Note: For most programs, you can substitute one printer model for another similar one.    However, because ClickBook prints 
double-sided, it needs very specific information about the actual printer you’re using.    If your printer model is not in ClickBook’s 
list, it’s best to use Custom Printer Setup Wizard.



 Easy Printer Setup dialog 
The Easy Printer Setup dialog allows the user to select the printer they want to set up as long as the printer’s driver is on the 
computer already.



Custom Printer Setup Wizard – Overview    

Summary of what Printer Setup does: First, the program prints two (single-sided) pages and asks you a question about how they 
printed.    Next, you’re instructed on how to reinsert the printout and begin printing the second pass.    Afterward, you’re again 
asked to report on what the printout looks like.

Here’s how to make a Custom Printer Setup:

1. Make sure the printer you wish to setup is ready to print (turned on, online, paper loaded, etc.)

2. Start ClickBook in standalone mode.

3. From file on the menu bar select ClickBook Printer Setup.

4. Select your printer in Printer to Set Up.    ClickBook will create a “ClickBook” version of this printer.

Click the Custom Printer Setup button when you’re ready to start.    Follow the instructions presented on the screen.

_______________

See also…

Custom Printer Setup Wizard Step 1



Custom Printer Setup Wizard Step 2

Custom Printer Setup Wizard Step 3

Custom Printer Setup Wizard Step 4

Custom Printer Setup Wizard Step 5

Custom Printer Setup Wizard Step 5b

Custom Printer Setup Wizard Step 6



Custom Printer Setup Wizard Step 1          

Custom Printer Setup Wizard – Step 1 asks    you if you have the two pages which were printed.    Once you have the two pages 
click on the I have the pages button.

_______________

See also…

Custom Printer Setup Wizard Overview

Custom Printer Setup Wizard Step 2

Custom Printer Setup Wizard Step 3

Custom Printer Setup Wizard Step 4

Custom Printer Setup Wizard Step 5

Custom Printer Setup Wizard Step 5b

Custom Printer Setup Wizard Step 6



Custom Printer Setup Wizard Step 2          

The Custom Printer Setup Wizard – Step 2 Helps figure out what the printed page looks like.

_______________

See also…

Custom Printer Setup Wizard Overview

Custom Printer Setup Wizard Step 1

Custom Printer Setup Wizard Step 3

Custom Printer Setup Wizard Step 4

Custom Printer Setup Wizard Step 5b

Custom Printer Setup Wizard Step 6



Custom Printer Setup Wizard Step 3         
The Custom Printer Setup – Step 3 informs the user how to place the two sheets back into the printer.

_______________

See also…

Custom Printer Setup Wizard Overview

Custom Printer Setup Wizard Step 1

Custom Printer Setup Wizard Step 2

Custom Printer Setup Wizard Step 4

Custom Printer Setup Wizard Step 5

Custom Printer Setup Wizard Step 5b

Custom Printer Setup Wizard Step 6



Custom Printer Setup Wizard Step 4          

The Custom Printer Setup – Step 4 asks if the two pages have printed out.

_______________

See also…

Custom Printer Setup Wizard Overview

Custom Printer Setup Wizard Step 1

Custom Printer Setup Wizard Step 2

Custom Printer Setup Wizard Step 3

Custom Printer Setup Wizard Step 5

Custom Printer Setup Wizard Step 5b 

Custom Printer Setup Wizard Step 6



Custom Printer Setup Wizard Step 5          

The Custom Printer Setup – Step 5 helps figure out what the printed pages looks like.

_______________

See also…

Custom Printer Setup Wizard Overview

Custom Printer Setup Wizard Step 1

Custom Printer Setup Wizard Step 2

Custom Printer Setup Wizard Step 3

Custom Printer Setup Wizard Step 4

Custom Printer Setup Wizard Step 5b

Custom Printer Setup Wizard Step 6



Custom Printer Setup Wizard Step 5b    

The Custom Printer Setup – Step 6 helps figure out what the printed page looks like.

_______________

See also…

Custom Printer Setup Wizard Overview

Custom Printer Setup Wizard Step 1

Custom Printer Setup Wizard Step 2

Custom Printer Setup Wizard Step 3

Custom Printer Setup Wizard Step 4

Custom Printer Setup Wizard Step 5

Custom Printer Setup Wizard Step 6



Custom Printer Setup Wizard Step 6            

The Custom Printer Setup Wizard – Step 6    finishes and saves all printer settings.

_______________

See also…

Custom Printer Setup Wizard Overview

Custom Printer Setup Wizard Step 1

Custom Printer Setup Wizard Step 2

Custom Printer Setup Wizard Step 3

Custom Printer Setup Wizard Step 4

Custom Printer Setup Wizard Step 5

Custom Printer Setup Wizard Step 5b



 Printer Settings dialog                                                                            

To use ClickBook’s Printer Setup

1. Open ClickBook Printer Setup.

· Click the Windows Start button to display the Start Menu.

· On the Start Menu, go to Programs, Blue Squirrel, ClickBook Printer Setup

OR

· Click the Windows Start button to display the Start Menu.

· On the Start Menu, go to Programs, Blue Squirrel, ClickBook

· In ClickBook Select the file Menu, Click on ClickBook Printer Setup

2.          Select Printer Settings.

The Printer Settings dialog allows the user to make the necessary changes for their printer, such as setting your printer up for 
duplexing (printing both sides of a piece of paper without human intervention).

 



Adding Page Numbers                                                                         

1. Click on the Options button  on the Toolbar or click Tools on the Menu bar and select Options.

2. In the Options dialog box click the box next to Print Page Numbers.

                                                               

3. Click OK.    Page numbers will now be placed in the bottom center position of your print job.



Print Assembly Instructions                                                

To turn on the Assembly Instructions:

1. Click the Options button  on the toolbar.    This will bring up the Options dialog box.

2. Click in the box next to Print assembly instructions.

                      

3. Click OK.



Border  

1. Click on the Options button  on the Toolbar or click Tools on the Menu bar and select Options.

2. In the Options dialog box click on the Paper, Borders tab.

                                                                    

3. In the Borders box you can select the type of border you want and the thickness of the lines.

4. Click OK.    A border will now be placed around your print job.



Drag & Drop  

Once you’ve created a shortcut on your desktop or on your Windows task bar to a ClickBook Printer you can easily select files, 
and drag and drop them onto the ClickBook Printer icon.    Then ClickBook will automatically launch the program the file was 
created in, and print the file to ClickBook.    This is a great way to speed up the printing process. 

To place a ClickBook Printer Shortcut on your desktop please follow these steps:

1. From the Start Menu, select Settings, then Printers. The Printer dialog box appears with a list of your printers. 

2. Select the ClickBook Printer you frequently use, right click, and click on Create Shortcut.

3. Windows will ask you if you want to create the shortcut on your desktop. Click Yes. 

4. If you do not receive the Windows message simply activate your desktop, right click, and select paste shortcut.

Wonderful! Now you can simply drag documents onto the printer icon to print using ClickBook.

To place a ClickBook Printer Shortcut on your taskbar please follow these steps:    (Please note: in order to create a 
shortcut on your Windows Taskbar you must have version I.E. 4.0 or later.)

1. Click on My Computer, and select Printers or from the Start Menu, select Settings, then Printers.    The Printer dialog box 
appears with a list of your printers. 

2. Select the ClickBook Printer you frequently use.

3. Click and drag the file onto your taskbar.

Congratulations! Now you can easily Drag & Drop files onto your ClickBook Printer on the taskbar to print with ClickBook!



Exchange Layouts  

From ClickBook’s ePrint everything Community, http://www.clickbook.com, you can submit, and download new layouts from 
other users around the globe! 

To Submit a layout: Please send it as an attachment to: layouts@clickbook.com. 

To download a layout: 

1. From the http://www.clickbook.com/layouts.asp, Web site select a layout you wish to download and click on it.

2. The File Download Dialog Box appears, mark the Save File To Disk radio button and select OK.

3. The Save As dialog box appears. Browse to the folder you would like to store the file in and click OK.

4. The File is saved as a ZIP file, which you will need to open and extract. 

5. Extract the file to ClickBook’s layouts folder. The Default layouts folder is in C:\Program Files\Blue 
Squirrel\ClickBook\Layouts\Favorites. You must select a category (Favorites, All, Booklets, etc.) to store the file in, DO 
NOT store the file in the layouts folder.

The .cb2L file is now stored in your layouts! When you open up ClickBook you will be able to print using this layout!



Instant Printing  

Instant Printing, or 1-step printing automatically starts the printing process when you elect to print from a program (No ClickBook 
program intervention). If you’ve already printed a document once, and print it again using ClickBook it will use the same layout 
settings previously, such as, double-sided portrait to print the job. If you elect to print a different document ClickBook refers to the 
default layout settings, which is double-sided booklet to print the job. To enable Instant Printing please follow these steps:

1. Click on the Options button  on the Toolbar or click Tools on the Menu bar and select Options.

2. In the Options dialog box click on the Program Settings tab, and mark the Instant Printing check box.

3. Click OK.    Instant Printing is now enabled! 



Print a Table of Contents                                                

To print a Table of Contents:

1.          Click on the Options button  on the toolbar.    This will bring up the Options dialog box.

2. Put a check in the box entitled Print a Table of Contents Page.



Printing a Multi-document Booklet                

Summary: To print several documents as a single booklet, just wait to click ClickBook’s Print button until after you have sent all 
the documents to ClickBook.

When you send a document to ClickBook, ClickBook pops up and begins receiving and processing the document.    If you send a 
second document, as long as you have not yet clicked ClickBook’s Print button, the second document becomes part of the same 
booklet.    You can send a third document, and so on.    The documents can come from different applications, but must be sent to 
the same printer.

Note: If you want to print from many applications, you can close each application as soon as it has finished printing (sending the 
pages) to ClickBook.    This may help if you find that you don’t have enough memory, or that your computer is operating slowly.

Once you have sent all of the desired documents to ClickBook, you can adjust settings – for example, select a different layout.    
Notice that all of your desired documents in the Print Jobs box.    If you want to cancel any of your documents from printing just 
click on the check mark in the box next to the documents name.    If you want the documents to print in a different order just left 
click and hold on the document you want to move and slide to the desired order of the print job. 

Finally, once you have verified the contents of the booklet and you are ready to print, click Print.

Important: The defining document

The first document you send to ClickBook for a given booklet is the defining document.    ClickBook uses the following settings 
from the defining document for all the documents you print together as one booklet.

· Printer

· Page settings (set these in your application or through Windows printer setup):

Resolution (dpi)

Page orientation (portrait/landscape)

Page width and height

· Layout (set in ClickBook)

All documents in a booklet should have the same settings as the defining document.    Otherwise, ClickBook will display a 
warning message and printing the booklet may produce unpredictable results.

Tip: To make sure the settings match, or to find out what the discrepancies are, you can view a list comparing any document with 
the defining document.    Just select that documents name (in the Print Job box) and then right-click on it.

Use the same CB printer for each

All documents printed together in one booklet must, of course, be sent to the same ClickBook printer.    Some application 
programs remember the printer last used for each document.    If your application does this, check the printer for each document 
before giving the print command.

Printing multiple documents as separate booklets

If you wish to print multiple documents as separate booklets one immediately after another, simply click ClickBook’s print button 
for one document before you send the next document to ClickBook.    Or , if you send documents to different printers, each 
printer’s set of documents will be printed as a separate booklet.



Types of layouts   

This topic will be easy to understand if you read it while looking at ClickBook’s Print Preview screen.    Select various layouts in 
turn, and compare each one.

What is a Layout?

A layout is a blueprint for a particular kind of booklet.    It is defined by a group of detailed settings that tell ClickBook how to 
arrange the mini-pages on the sheet of paper.    Some of the essential details are whether the paper orientation is portrait or 
landscape, how many mini-pages are printed across and down on one sheet, and whether to print single- or double-sided.    
Some fine-tuning settings are also part of each layout, such as sizes of margins and added space for binding.

Booklet Styles

Each layout also has a certain booklet style.    This relates to how you intend to assemble and bind the booklet, and tells 
ClickBook in what order to print the mini-pages so they will end up in the right order in your finished booklet.    There are six 
booklet styles: cut book, folded book, French fold, planner pages, tiled, and tri-fold.

You can determine a layout’s booklet style from:

¨          The layout name.

¨          The layout picture.

¨          The Booklet Style on the Modify Layouts tab.

Cut books are for methods of binding that require cutting between facing pages.    Most of the cut book layouts shipped with 
ClickBook are designed for paper that’s pre-perforated for a custom appointment-book page.

Folded books are designed for folding between facing pages, and stapling.    Examples include the “Address book (folded)”, 
“Wallet book (folded)”, and “Side-by-side (folded)” layouts.

French fold layouts are for making greeting cards from standard paper by folding the printed sheet in fourths.      The French fold 
style expects exactly four pages per sheet.

Planner pages is designed for day planner laser paper that has holes on the left and right hand sides.

Tiled layouts are designed for multiple pages on a sheet but not cutting the sheet.    The sheets that come out of    the printer are 
the final sheets.    There are two sequences in which the mini-pages can be printed in a tiled layout.    These are controlled by the 
Binding Orientation options on the Modify Layouts dialog.

· Row-wise means page 2 prints to the right of page 1.    For row-wise order, select the Standard binding orientation.

· Column-wise means pages 2 prints below of page 1.    For column-wise order, select the Flip binding orientation.

Tri-fold is for printing single- sheet brochures or leaflets which are folded twice, making three panels (mini-pages) on each side 
of the paper.      The tri-fold style expects exactly six pages per brochure, since this style of brochure is a single sheet of paper, 
folded. 

Tri-fold pagination has pages 5, 6, and 1 on one side, and pages 2, 3, and 4 on the other.    The front panel is thus page 1, and 
the reader opens up the brochure to see pages 2, 3, and 4 inside, and then turns the sheet over to read pages 5 and 6.

 



Layout list and picture 
To see the list of available layouts, click on the Layouts drop down box.    You can select a layout by clicking on it.

The layout list and print preview screen work together.    The print preview always shows the layout that’s currently selected in 
the Layouts drop down box. 

After selecting a layout, look at the picture and the layout name carefully to assure that it’s exactly the layout you wanted.    There 
are several versions of many layouts with slight but important differences.

How to interpret the picture

The picture shows a single sheet of paper.    It informs you how many pages print on a sheet, in what orientation, and with what 
pagination scheme.

The margins, including the Binding margin, are shown in blue.

The heavier, dashed lines show where you will cut, and the lighter dotted lines indicate where the booklet will be folded.



Selecting a layout 

Answering the following series of questions will help you decide which layout you want.    To see the available layouts, click on 
the Layouts drop down box and scroll up or down.    To see a layout’s settings, select Layouts on the Menu bar and click on 
Modify Layouts.

¨ Is your document oriented as portrait or landscape?    You should choose a layout that orients the mini-pages in the same 
way.    Look at the picture for each layout to determine its mini-page orientation.    (ClickBook will warn you if you choose a 
layout that isn’t matched.

¨ What sort of booklet do you want to print? 

Mini-page size

Finally, for books or tiled layouts, how large do you want your finished mini-pages to be?    This determines how many mini-pages 
you want per sheet, and how to fit them on the size of paper you’re using.    To choose a layout with an appropriate number of 
mini-pages, look at the print preview picture.

Check the size of your fonts and graphics.    Small booklets usually require that you enlarge the fonts and graphics, unless you 
choose to use No Scaling.    Enlargement must be done in your application program.

About font size

If you realize after choosing a layout in ClickBook that your text or graphics will turn out too small, you should Cancel the print 
job.    Then, back in your application program, enlarge the fonts and graphics, and issue the print command again. 



Tri-fold brochures  

 

The Tri-fold and Tri-flip layouts produce single-page flyers or leaflets that you fold twice to make three panels.    The front panel is 
page 1, and the reader opens up the brochure to see pages 2, 3, and 4 inside, and then turns the sheet over to read pages 5 
and 6.

  

 

The difference between these layouts is in how you turn the brochure to read it (the "binding orientation").    To read a Tri-fold 
brochure, you orient it as tall and narrow, and open it up with the panels arranged side by side.    To read a Tri-flip brochure, you 
orient it to be wide with few lines of text, and open it up with the panels one above another. 

About No Scaling

The brochure layouts have the No scaling setting on.    This means that ClickBook does not reduce the document's pages.    Text 
and graphics are printed at the same size they're set to in your application program.    Why?      As you can see in the pictures 
above, a brochure has tall, very narrow (or wide, very short) mini-pages.    Scaling a normal page size down to this shape would 
distort your fonts and graphics. So instead, you set up the page in your application program exactly as you want it to print, 
including matching the mini-page size.    Then ClickBook prints the pages in the necessary order but without shrinking them.

Creating a brochure

Different application programs require different methods of matching the mini-page size. 



Creating and removing layout Categories                    

Creating a new Layout Category

To create a new layout Category follow these steps:

1. From the ClickBook directory in the Windows Explorer, open    the Layouts folder.

The default directory is C:\Program Files\Blue Squirrel\ClickBook\Layouts. 

2. Create a new folder by right clicking the mouse inside the Layouts folder where there is blank space, and select new and 
click on folder .

3. This folder will now be a new Layout Category, name it whatever you would like.

4. To select what layouts you would like in this new category open the All folder, which is inside of layouts, and copy the 
layouts you want and paste them in the new category folder.

Removing a Layout Category

1.  From the ClickBook directory in the Windows Explorer, open    the Layouts folder. 

The default directory is C:\Program Files\Blue Squirrel\ClickBook\Layouts.

2. Select the folder you no longer want and hit the delete key.



Selecting icons for layout categories                  

The icon which you desire to use must be in the icons folder in the ClickBook directory.

Changing the Icon of a Layout Category

To change an icon follow these steps:

1. From the ClickBook directory in the Windows Explorer, open    the Icons folder, which is found in the ClickBook directory.    
Now decide which icon you would like to use.

The default directory is C:\Program Files\Blue Squirrel\ClickBook\Icons.

2.          Now decide which icon you would like to use.

3. Open    the Layouts folder.

The default directory is C:\Program Files\Blue Squirrel\ClickBook\Layouts.

4. Double click the folder of the Layout Category whose icon you wish to change, open the cat.ini file. 

Note:    If there is no cat.ini file copy one from one of the other Layout Category folders.

5. Highlight whatever is after icon= and type in the name of the icon you are going to use.

6. Save and close the cat.ini file.

Now your icon in ClickBook is changed.



Creating or modifying a layout                               
Making a backup

For backup purposes, you may want to save all of the original layouts before making changes to them.    You can do this by 
copying the Layouts folder to a new name or to a backup disk.    (It is in your Windows directory.)    Then, if you ever need to 
revert to the originals, just restore the original files.

Creating a layout

To create a new layout, you modify an existing one and rename it:

1. From the menu bar open layouts and select either Layout Wizard or Modify Layout. 

2. Choose any layout that’s similar to what you want.

3. Change any settings to create just the layout you want.

4. Click the Save As button and save the new layout with a new name.

Modifying a layout

1. From the menu bar open layouts and select either Layout Wizard or Modify Layout. 

2. Choose any layout that’s similar to what you want.

3. Make the desires changes.

4. Click the Save button.

Undoing Changes

To undo all changes you haven’t yet saved, click the Abandon Changes    button.

Previewing a layout

For a rough preview of your new or changed layout, examine the print preview picture, which shows most of the layouts settings.

If you are satisfied with how the booklet looks, click Print to start printing directly from Print Preview.    If you are not satisfied, 
then go to Modify Layouts, found in Layouts on the menu bar, and fix the layout.



No Scaling 

If you have prepared your document’s pages to be the final printed size you want, you should use ClickBook’s No scaling option. 
When no scaling is on, ClickBook does not shrink the pages.

Before printing this way, make sure that (a) you have assigned appropriate font sizes, and (b) the size of your document’s pages 
match, or are smaller than, the mini-page size of the layout you wish to use.    You can set the page size in your application 
program either with the page width and height settings or with the right and bottom margin settings.

Choose a No scaling layout…

Some layouts already have No scaling on. 

…Or turn off scaling on any layout

To use No scaling, print your booklet mostly as usual, with these special steps:

¨ In choosing a layout, make sure that its mini-page width and height match the dimensions of your document’s pages.    (It’s 
okay if the mini-pages of the layout are slightly larger, the booklet pages will simply have larger right and bottom margins.)

¨ In the Scaling section of the Modify Layout dialog, turn on No Scaling.    Then click Save As to save this new layout with a 
different name.



Repeat 

The effect of Repeat, an option on the    Modify Layout dialog box, depends on the layout it’s applied to. 

Of the layouts shipped with ClickBook, the two “Business card” layouts and the two “Greeting card (heavy stock repeat)” layouts 
have Repeat turned on.

Repeat can be used to print more copies when there aren’t enough mini-pages to fill the sheet.      Repeat can also be used, 
alternatively, to avoid the step of assembling multiple booklets. 



Sharing layouts with other users                   
You can use another ClickBook user’s customized layouts, or share any that you’ve created or modified, through the folder 
Layouts and selecting the category for the layout.    A ClickBook layout ends with .cb2l.

The ClickBook Layouts folder, which is found in the ClickBook directory in Windows, contains the definitions of all the layouts in 
your ClickBook system, including all of your modifications and additions.

To use another ClickBook user’s layouts

Copy the .cb2l file(s) you want and save it to whichever Layout directory you would like.    When you next start ClickBook, the 
new layout(s) will be listed.

Before using a layout someone else created, check the following on the Modify Layouts dialog.

¨ Is the Use Absolute Dimensions option on?    If so, it may be designed for special paper.    Check the mini-page Width and 
Height.

¨ Note the Paper Size, which may be different than you normally use.

¨ Is Scaling set to the option you want?

To delete an unwanted layout

Highlight the unwanted .cb2l file and push the delete key.



Printing multiple copies sequentially 

To print multiple copies of the same print job:

1. As usual, print from your application program to a ClickBook printer.

2. When ClickBook pops up, set the Num of copies option.

3. Click Print.    ClickBook prints the first sides of all copies, with a single instruction sheet.

4. After the first sides of all copies have finished printing, put the whole printout stack back in the printer.

5. Click the Print Second Side button.

6. After the second sides of all copies have finished printing, separate the copies.

7. Cut, assemble, and bind each booklet individually.

Note: 

If you want to print multiple identical booklets, follow the instructions above.    Setting multiple copies within your application 
program will not work correctly.



Previewing the printout                                                                  

The Print Preview lets you see how your document will look when printed with the selected layout.    It is not accurate in every 
detail, and your printout will look better than the preview.    But the Print Preview enables you to see most features of the printout, 
such as:

¨ How mini-pages are positioned.

¨ The relative sizes of margins and data.

¨ How many sheets will print.

¨ How many blank mini-pages will be printed at the end.

Note:

1. ClickBook’s Print Preview is not designed for viewing each mini-page in detail.    For this, use your application program.

2. If you see apparent glitches (such as text not centered on each mini-page, or text extending over the right edge), the 
inaccuracy may be only in the preview.    For more accurate previews, try the following:

a. Zoom a mini-page.

b. Print a sample page.

Displaying different sheets of the booklet

Use the bar beneath the picture to navigate to different sheets of the booklet:

¨ To go to the first or last sheet, click the arrow button at the left end or right end of the bar.

¨ To go to the next previous sheet, drag the slider button left or right.    When the desired sheet number is shown, release the 
mouse button.

¨ To go to the next or previous sheet click the bar on the left or right side of the slider, depending upon which way you want to 
go.

Which side?

Use the front and back buttons to see the other side of the currently displayed sheet.

Printing a sample sheet

For a 100% accurate sample of the printout, print a test sheet.    Use Sheet Selection to select the sheet to print.



Reinserting the printout stack                                    

The critical step of double-sided printing is correctly reinserting the first-side print out correctly into the printer so the second side 
can be printed.    Each detail of this process is important:

¨ When you are certain that all of the sheets from the first-side printout are done, remove the printout stack from the printer 
without rearranging the pages.    Make certain. If any other print jobs were sent to this printer, that you are holding only your 
intended printout.    If you’re on a network and a printer prints an extra sheet (blank, or with network user id, for example) 
between printouts, throw out that sheet.

¨ Turn the stack over if necessary to find the instruction sheet.    Read the instruction sheet without lifting it off the stack.

¨ Reinsert the stack with the instruction sheet still on it.

¨ If your printer puts out an extraneous sheet before each print job ( e.g. printout separator sheets on network printer), place 
a blank sheet on top after reinserting the stack.    If the printer went offline when you reinserted the stack, put it back online.



Return to ClickBook after printing                

With the Return to ClickBook after printing option turned on, ClickBook will remain open after printing is completed.    You’ll then 
be able to do any of the following.

¨ Reprint a sheet or a range of sheets.

¨ Save the booklet just printed as a .cb2 file.

¨ Print the document as a different layout.

¨ Modify the layout and print the document again

Before you click Print, you can find Return to ClickBook after printing on the Program Settings Tab in Options.    If you turn it on 
there, it stays on for future print jobs.    While the booklet is printing, Return to ClickBook after printing is available in the 
ClickBook status window.    If you turn it on there, it stays on only for the current print job.



Printing a range of sheets                                                      

Sometimes you want to print only a part of a booklet, for reasons such as:

¨ Before printing the whole booklet, you want to print a sample sheet to see how it looks.

¨ A sheet of paper jammed in your printer or came out creased.

¨ After printing, you needed to make a small change that affected just a few pages of your document and did not change the 
pagination.

¨ Sheet #3 fell on the floor and the dog ate it…

Whatever the reason, you can reprint just the affected sheets, rather than the entire print job.    Here’s how:

Note: You can print one sheet or a continuous range, but not discontinuous sheets (like 1 and 4).    Of course, with Return to 
ClickBook after printing turned on, you can print one range of sheets now, and then when you return to ClickBook after that 
printout finishes, you can print another range.

1. Prepare for the possibility of reprinting before the booklet finishes printing.    Do this by turning on Return to ClickBook after 
printing.

Before you click Print, you can find Return to ClickBook after printing on the Program Settings Tab in Options.    If you turn it 
on there, it stays on for future print jobs.    While the booklet is printing, Return to ClickBook after printing is available in the 
ClickBook status window.    If you turn it on there, it stays on only for the current print job.

2. When the printout is finished, ClickBook will return.

3. Click the Sheet Selection button.

4. Specify the range of sheets to be printed by setting First Sheet and Last Sheet.    You must specify the first and last sheet by 
number. 

How to see different parts of the booklet

¨ To see the other side of the currently displayed sheet, use the Front Back buttons.

¨ To switch between viewing a single mini-page and a whole sheet, click on the picture.

¨ To navigate to various sheets of the booklet, use the bar beneath the picture: 

¨ To go to the first or last sheet, click the arrow button at the left end or right end of the bar.

¨ To go to the next previous sheet, drag the slider button left or right.    When the desired sheet number is shown, 
release the mouse button.

¨ To go to the next or previous sheet click the bar on the left or right side of the slider, depending upon which way you 
want to go.

5. Choose the desired option for printing fronts and/or backs of the sheets.    Also choose whether or not to print the instruction 
sheet.

6.          Click Print to begin printing.



Printing to a file 

Suppose you want to print a booklet on a friends printer, but the friend doesn’t have ClickBook installed.    You can create print 
files on your computer, then print those files directly from Windows on your friends computer.

Note: If you want to prepare a booklet now and print it later on your system (or another ClickBook system), just save the booklet 
as a .cb2 file.

Before you start: The printer must already be installed on your Windows system; you may need to get the driver file from your 
friend.    Also, you must have run ClickBook’s Printer Setup for this printer.

Here’s how to print a file, and later to a printer:

1. In your Windows Printer Setup, connect the ClickBook or CB printer you want to use to “FILE:”.

2. In your application program, print your document to the ClickBook printer that’s now connected to “FILE:”.

3. At the prompt, enter a filename for the first print file (for the first side).

4. When the front side has “printed” to the file, you can click the Print Second Side button right away, since there is no paper 
to reinsert.    At the prompt, enter a filename for the second print file (second side).

5. Whenever you are ready to print to the printer, take the two print files to your friend’s Windows system.    Print the first-sides 
file.

6. When that file is done printing, reinsert the paper and then print the second-sides file.



Installing another printer in ClickBook    

 

You have already installed ClickBook and now wish to install an additional (or a first) ClickBook printer.    Note: You don’t need 
another driver.    A Windows printer driver for the printer, and ClickBook, are all you need.

Follow these steps:

1. First, make sure that the printer is installed in your Windows system.

2. In standalone mode, go to ClickBook Printer Setup which is found in the File menu.

· Click the Windows Start button to display the Start Menu.

· On the Start Menu, go to Programs, Blue Squirrel, ClickBook

· In ClickBook Select the file Menu, Click on ClickBook Printer Setup

3. Choose your printer model from the Printer to Set Up list.

4. Click Easy Printer Setup

5. Make sure the correct printer is highlighted, and click OK.

If your printer is not on the list, click Cancel.    Then run Custom Printer Setup.

Note: For most programs, you can substitute one printer model for another similar one.    However, because ClickBook prints 
double-sided, it needs very specific information about the actual printer you’re using.    If your printer model is not in ClickBook’s 
list, it’s best to use Custom Printer Setup Wizard.



Setting up a duplexing printer 

Using a duplexing printer (one that handles double-sided printing) with ClickBook is easy.    ClickBook sends out only one print 
job for both the front and back sides, so you skip the step of reinserting the printout stack and then printing the second print job. 

Note: If you use only a duplexing printer, ignore any Help that concerns reinserting the paper before printing the second side.

Follow these steps to prepare your duplexing printer:

1. First, make sure that the printer is installed in your Windows system

2. While in standalone mode, go to File on the menu bar and click on ClickBook Printer Setup.

3. Choose your printer model from the Printer to Set Up list.

4. Click Easy Printer Setup

5. Make sure that the correct printer is highlighted in the “same paper path” list, and click Printer Settings.

6. Choose Automatic duplexing.

7. Select the printer style.

There are 4 different styles of duplexing printers.    They are:

Style 1    - The most common duplex style.    This is the default setting.    Duplexing is based on the orientation of paper 
where short edge represents the horizontal edge.

Style 2    - The reverse of “Style 1”.    Commonly used by PostScript drivers.    Duplexing is based on the orientation of 
the paper where long edge represents the horizontal edge.

Style 3    - This style is independent of the orientation of the paper.    Duplexing is based on the horizontal axis 
representing the horizontal edge.    This is the way the Windows API expects printer drivers to duplex.

Style 4    - This style is the reverse of “Style 3”.    It is also independent of the paper.    Duplexing is based on the 
horizontal axis representing the vertical edge.



8. Click OK. 



Custom Printer Setup                                                                              

Summary of what Printer Setup does: First, the program prints two (single-sided) pages and asks you a question about how they 
printed.    Next, you’re instructed on how to reinsert the printout and begin printing the second pass.    Afterward, you’re again 
asked to report on what the printout looks like.

Here’s how to make a custom Printer Setup:

1. Make sure the printer you wish to setup is ready to print (turned on, online, paper loaded, etc.)

2. Start ClickBook in standalone mode.

3. From file on the menu bar select ClickBook Printer Setup.

4. Select your printer in Printer to Set Up.    ClickBook will create a “CB” or “ClickBook” version of this printer.

5. Click the Custom Printer Setup button when you’re ready to start.    Follow the instructions presented on the screen.



Setting margins and binding space          

To change margins, on the menu bar select Layouts and click on Modify layouts.    The margin settings are changed by clicking 
the up and down arrows on the number boxes.    To make a big increase or decrease, hold the mouse button down    until the 
desired value is reached.

To see the results, watch the layout picture, which redraws automatically to show the margin changes.

Important:

¨ ClickBook’s margins are in addition to the margins set in your application program.

¨ Unlike the application program’s margins, which gets scaled down along with the contents of your document, ClickBook’s 
margins print at the exact size specified.

Usually you should set your application program’s page margins or ClickBook’s Top/Bottom and Left/Right Mini-page Margins.    
If you choose to set ClickBook’s we recommend that you first print a part of your booklet and measure the exact of margin you 
want to add.    Then print the entire document with the Mini-page margins set correctly.

The Binding margin is extra space only on the side where the book will be bound.    (The Binding orientation setting determines 
which side that it.

Set the Paper Margins to match the cut-away or pre-perforated tear-off areas around the edges of some custom papers.



Printing sub-booklets to bind together  

Rather than folding a whole booklet together, you may wish to print and fold sub-booklets separately, and then bind them 
together.    To do so, go to the Layouts on the menu bar and select Modify Layout.    Now turn on Sub-booklets.    Then set Pages-
per to the number of pages you want each sub-booklet to contain.

Reasons for using sub-booklets include:

¨ To avoid shingling or margin creep that otherwise occurs with thick folded booklets.

¨ To meet the needs of special binding methods.

¨ To separate individual documents from a mail-merge print stream.



Scaling options 

The three scaling layouts in the Modify Layout dialog box enable you to control how and whether ClickBook shrinks (scales) the 
pages of your document.    These options are: Stretch-to-fit, One-to-one, and No scaling.

Stretch-to-fit

Stretch-to-fit is the scaling setting for most of the ClickBook layouts.    When a layout has Stretch-to-fit on, ClickBook receives the 
document pages from your application program and scales (shrinks) as necessary to fit on the layout’s mini-page    size.    When 
you use stretch-to-fit, be sure to set the fonts large enough in the application program to be readable after they’re scaled down.

Preserving the shape of graphics and text

As ClickBook shrinks the pages of your document down to the mini-page dimensions of the selected layout, the shape of the 
page may change substantially.    In such cases, the shape of the fonts and graphics may be excessively changed.

To prevent this, select the One-to-one option in Modify layout.    ClickBook will then shrink the pages proportionately without 
altering their shape.    The resulting text or graphics will be somewhat smaller than with Stretch-to-fit, and each mini-page will 
have some extra white space.

Do-it-yourself: The No Scaling option

If you wish to print text and graphics at exactly the size you’ve prepared them in the application program, select the No scaling 
option.    With No scaling on. ClickBook prints one application page on one mini-page without shrinking the data, leaving you to 
set up the application page exactly as you want it to print.

This option often solves problems that may occur with scaling.

Before printing a document with No scaling, prepare it as follows in the application program:

¨ Set fonts to the actual size you want them in the printout.

¨ Set the document’s page size (in the application program) to match the mini-page size (of the ClickBook layout you plan to 
use).

You must make certain that the document’s page size is smaller than or the same as the layout’s mini-page size.    Unless you 
have a reason to do otherwise, set the page size to exactly match the mini-page size.    You can set it by either setting the page 
dimension settings, or by changing the margins so that the data area has the desired dimensions.

Note:    In some applications it is necessary to use margin settings to accomplish this.



Cutting and assembling                                                          

For layouts that require cutting and assembling the printout to form a book, instructions can be printed with your printout.    The 
same instructions are given below.    Note to print these instructions with each booklet, click on the Options button and turn on 
the Print assembly instructions option.

The cut marks on the printout are guidelines that show between which mini-pages to cut.    Their position is accurate to about 
1/16”, which is not high precision for very small mini-pages.    Use your eye or measure, in order to cut precisely halfway 
between mini-pages.

The marks themselves tell you the order of the cuts.    The solid line indicates the first cut, the line composed of two dashes 
indicates the second, the line composed of three dashes indicates the third, and so on.

The instructions below, or those printed with the printout, include the important information about how to re-stack the cut sheets 
after each cut.    They give the general rules for cutting and assembling any book of any layout.

1. If the mini-pages do not fill the sheet (that is, if you specified absolute mini-page dimensions), the first step is to cut away 
the extra paper.    If there is no extra to cut away, skip to step 2.

a. Cut at the “one-dash” cut mark, which indicates a vertical cut to eliminate extra paper on the right.    Discard the 
extraneous strips.

b. Cut at the “two dash” cut mark, which indicates a horizontal cut to eliminate extra paper at the bottom.    Discard the 
extraneous strips.

2. Make the leftmost vertical cut.    (Look for the next cut mark.    Depending on whether you did steps 1.a. and/or 1.b., this may 
be composed of one, two or three dashes.)

3. Now your printout is split into two stacks.    Place the one with page 1 on top of the other, aligning the top left corners.

4. Make the leftmost remaining vertical cut, if any.

5. Again, place the page 1 stack on top of the other, with top left corners together.

6. Continue in the same way until all vertical cuts have been made.

7. Make the top horizontal cut.

8. Place the page 1 stack on top of the other, with top left corners together.

9. Make the topmost remaining horizontal cut if any.

10. Place the page 1 stack on top of the other, with the top left corners together.

11. Continue in the same way until all horizontal cuts have been made.

12. Be sure to fold and/or bind on the edge indicated by your choice of layout, namely binding on the left for a Standard book, 
or on top for a Flip book. 

a. For a folded booklet layout: Remove blank mini-sheets, if any, from the middle.    Fold in half and staple.

b. For a cut book layout: Remove blank mini-pages, if any from the end.    Then bind.



Mini-pages shift to the right                                          
Problem: 

In the printout, the mini-pages are shifted to the right or down, while printing is clipped at the right hand or bottom edge of the 
sheet of paper.

 

Explanation

This can occur with many applications (for example, WordPerfect and Microsoft Word) when you use a layout with the No 
Scaling option.    (The brochure layouts, for example, use No scaling.)    No scaling requires a custom page size to be set in the 
application program.    But if this custom page size does not match the page size of the printer, many application programs 
handle the mismatch in ways that are incompatible with ClickBook. 

 

Solutions

· If your printer supports custom-sized pages, set the printer's page size to match the page size set in your application 
program.    (You can set printer options using Window’s Printer Setup.)

 

· Otherwise, you need to adjust the effective page size by adjusting the margins in your application program.



Printer drivers and ClickBook printers 
A printer driver is a program that knows how to print correctly to a specific printer model.    Installing a printer in Windows means 
installing a printer.

To set up a printer in ClickBook, you run ClickBook’s Printer Setup, which creates a ”ClickBook printer”.    A ClickBook printer is a 
special name for your printer (driver) that causes ClickBook to pop up before your document reaches the printer.    When you 
print to a ClickBook printer name, ClickBook pops up and receives the print data stream from your application program.    After 
formatting the print data to fit the layout you choose, ClickBook sends it to be printed by your regular printer driver.    ClickBook 
does not alter your printer’s driver in any way.

In other words, by choosing a ClickBook printer, you are choosing ClickBook and a regular Windows printer (driver).    For 
example choosing “CB HP LaserJet 4” or “ClickBook HP LaserJet 4” means “I want to print through ClickBook to my HP 
LaserJet 4 driver”.



Surf 'n' Print Layouts                                                      

The two surf ’n’ Print layouts in ClickBook have a special property: They try to guarantee that you never have any text clipped 
out because of your printer’s unprintable region”.    This feature’s perfect when you’re surfing the Net or printing from a CD-ROM 
and don’t have control over any of the document’s margins.

This feature currently cannot be turned on for other layouts.



Printing under Windows NT                                

To use ClickBook under Windows NT 4.0 the printer driver MUST support Metafile Spooling.    When you setup a printer for use 
in ClickBook under Windows NT 4.0, the “ClickBook Printer Setup Help” pops up and launches the “Printer Advanced Document 
Properties” dialog for the specific driver.    Be sure to select “Document Options” and turn on Metafile Spooling.

If you can’t find this option than it is possible that the driver does not support Metafile Spooling.    A common symptom of this is 
that the document prints normally instead of popping up ClickBook even though you printed to the ClickBook or CB printer.    If 
this happens you should try another printer driver that is similar to the printer you are using.    For example you can use the HP 
LaserJet 5 driver with the HP LaserJet 6 printer.    If all else fails contact the printer manufacturer for drivers that support Metafile 
Spooling.



Uninstalling ClickBook                                                                

1. Click the Start button and select Settings, Control Panel from the Start Menu.

2. Double click the Add/Remove Programs Icon.

The Windows Add/Remove Programs Properties dialog box appears.

3. Select Blue Squirrel ClickBook in the list of software available, and click the Add/Remove button.

4. The following dialog confirms your request to uninstall/

5. If you are certain you want to uninstall ClickBook click the Yes button.



One Side is ‘Double-Exposed’ or Upside-Down                    

If the front and back sides of your printout are misaligned, check the following possible causes.

Explanation A:    A printer often gives you a choice of which tray to have the paper feed from, and also of the path the paper takes 
through the printer and where it comes out.    It's important that the paper paths of the first-    and second-side printouts are always the 
same as during Custom Printer Setup. 

It's possible your printer's paper path is nonstandard for that model, or that you've changed the paper path in some way since running 
Custom Setup.

Solution A

Run Custom Printer Setup (again, if you have run it already) -- using exactly the same paper path you want to use when printing booklets.

Explanation B:  If you printed a flip book, chances are good that when you reinserted the printout in order to print the second side, you 
did this incorrectly.    The flip book layouts require the sheets to be put in differently than do layouts with Standard binding orientation. 

Solution B1:    Have you turned off the Print second side instructions option?    If so, and if you plan to use both flip and standard binding 
orientations in the future, you may want to turn this option back on.    It makes it much easier to know how to reinsert the sheets for a 
particular print job.

 

Solution B2:    If the instruction sheet was printed, and you're sure that you followed it correctly when reinserting the printout stack, run 
Custom Printer Setup (again) to correct the instruction sheet.

 

Explanation C:    If the back sides are upside-down only when the sheet orientation is landscape, there may be an error in your printer 
driver.

Solution C1: The first solution is to run Custom Printer Setup again and then try printing again.    Do these three steps:

1.    Run Custom Printer Setup again. 

2.    On ClickBook's Options tab, if you previously turned off Print second side instructions, turn it back on. 

3.    Try printing with ClickBook again, and follow the instruction sheet carefully. 

If running Custom Printer Setup again did not solve the problem, the problem is in your printer driver.    Try solution C2, below.

Solution C2: ClickBook can work around the driver error if you provide accurate information about your printer.    Here's how to correct 
ClickBook's information about your printer:

1.    Open clickbook.ini in any ASCII text editor.    This file is in the windows directory.    See...    Viewing or editing .INI files 

2.    Search for the section heading [Printers].

3.    In that section, find the line with the printer's name.    At the end of the line is a string of 5 Y's and/or N's.

4.    Change the last letter.    If it was Y, make it N.    If it was N, make it Y. 

(What does this letter mean?    It's the answer to the question, "Does this printer rotate 90 degrees from portrait orientation to get landscape 
orientation?".    Y means "Yes, 90 degrees", and N means "No, 270 degrees".) 

5.    Save the file.



Text is Too Small to Read                                                  
When you use a layout that prints several mini-pages to a sheet of paper, fonts are scaled down substantially.    You may want to increase 
the font size in your application program. 

Note: Some fonts are more 'scalable' than others.    This means that they give ClickBook more flexibility to scale them down to just the 
right size.    We recommend TrueType fonts, which are fully scalable. 

 

The table below gives recommended minimum font sizes, based on the Arial font.    These are recommendations only, and you may wish 
to use smaller or larger fonts. On printers with high resolution, very small fonts are readable.    Also, if you use a font other than Arial, 
readability at various sizes may differ. 

Layout Recommended

Address book 20-pt. 

Business card 24-pt.

Business card (no scaling) *

CD jewel box 14-pt.

Fax 12-pt.

Flip book 12-pt. **

Four-up flip book 14-pt. **

Four-up landscape 14-pt.

Four-up portrait 14-pt.

Greeting card (all layouts) 14-pt.

Side-by-side 12-pt.

8-Up 18-pt.

Tri-flip brochure  *    **

Tri-fold brochure  *

Wallet book 26-pt.

Example:    The manual Getting Started with ClickBook was printed with the "Side-by-side" layout.    Its main body-text font was 14-pt. 
Times New Roman.

Notes

*      ClickBook does not scale fonts when using these layouts.    So, use the actual font size you want.
**    When using a flip book layout, set the paper orientation in your application program to Landscape.



Staples are Crooked or I Can’t Reach Fold with Stapler                        

Stapling Paper

Problem:    Standard staplers may not reach the fold on larger folded booklets, or the staples may go in crooked.

Solutions 

1- A 'long-reach' stapler, available at stationery and office supply stores, provides a good solution.    We've used the Stanley-Bostitch 
440LP with excellent results on all our folded layouts.

2- Another good solution is the Stanley-Bostitch B8SB 'saddle' stapler.    A folded booklet (up to 8.5"x11" when flat) slips into place on the 
stapler and staples straight every time. 

If you don't find these staplers at your local store, see the "Special Booklet Stapler Offer" in your ClickBook package.    Use this to order 
your booklet stapler directly from Blue Squirrel at a special price!

Tip:    Be careful to staple with the outside of the book facing you, so that the sharp side of the staple will be on the inside!

Paper cutting

Problem:    On most paper cutters, there is some play (sideways motion) in the cutting arm, which makes it hard to cut a perfectly squared 
edge (making right angles at the corners). 

Solutions

1- As you lower the cutting arm, press slightly inward (to the left) to keep the blade tight against the base of the paper cutter.

2- A rolling-blade paper cutter does an excellent job of trimming booklets.    Dahle -- (800) 243-8145 -- sells three models in the $50-60 
price range which make clean crisp cuts.    The Dahle cutter also neatly removes the shingling effect from folded books.



Pages of Booklet End Up Out of Order               
Problem:    The pages of your booklet are out of order after it's in its final form (cut, assembled, and/or bound as necessary). 

 

Causes and solutions

The cause is one of the following:

1- The Booklet Style of the layout doesn't match how you assembled the final booklet.    Each booklet style produces a different pagination 
in the printout, which will result in the correct pagination after assembling according to that style.    For example, if the layout has the Cut 
book setting, the pages will be out of order if you assemble it as a Folded book.

2- The Binding Orientation of the layout doesn't match how you assembled the final booklet.    For example, if the layout has the Standard 
setting, the pages will be out of order if you cut, assemble, and bind it as a Flip book.

Solution:    The solution is to print again.    When ClickBook pops up, select a different layout or modify the layout so that all settings are 
correct. Or, if you haven't already incorrectly cut or bound the book, you may want to simply cut, assemble, and bind it according to how 
it printed rather than as you had intended. 

3- You cut or assembled the booklet incorrectly. 

Solution: Check the cutting and assembly instructions.    (They may be printed with your printout, and they are in your ClickBook 
package, as well as in Help.

4- You reinserted the printout stack incorrectly before printing the second side (check the instruction sheet). 

Solution:    If the instruction sheet was wrong, run Custom Printer Setup again for that printer.

5- The option to print pages in reverse order was on in your application program.

Solution:    In your application program, turn this setting off.    Then print again.



Table or Spreadsheet Cells Print Overlapped          

Problem:    In some circumstances, spreadsheet cells may 'overflow' into their neighboring cells in the ClickBook printout. 

Solution:    Before printing the spreadsheet from ClickBook, go to the Options tab and turn on Round Font Size Down.

Explanation 

ClickBook scales down each font of your document to fit the mini-page size, but the precise size needed may not be achievable.      
Normally, it works fine for ClickBook to use the closest possible size.    However, in special cases as described above, if the text is even 
very slightly larger than ideal, some cells may extend too far to the right, overlapping the beginning of their neighbor cells. 

When Round Font Size Down is turned on, ClickBook always uses the precise size needed, or smaller.



Right-Justified Text is Uneven                                       

Problem:    Right-justified text, which should form a clean, even righthand edge, is sometimes uneven after ClickBook scales down the 
text. 

Solutions 

There are two solutions, the first a work-around, the second a true solution that's a bit more work.

1- Turn off right-justification in the application program.

2- Turn off scaling in ClickBook.    This requires some reformatting of the document in the application program.    For details, read about the 
No scaling option in ... Scaling options.



Printing Gets Clipped Near the Paper Edges            
 

Explanation:    Laser and inkjet printers maintain an "out-of-bounds" or unprintable region, usually about 1/4", around all four sides of the 
sheet of paper.    The margins you set in the application program may be larger than this region for actual-sized printing, but after 
ClickBook scales down the pages to mini-pages, the margins may be too small, causing the printer to truncate some of the data.

Solutions:

1- If you don't object to a small decrease in the mini-page size, set ClickBook's Paper Margins to the size of the unprintable region, and 
then cut these margins off before making any cuts to separate the mini-pages.

2- Otherwise, increase the margins in your application program, or add ClickBook Mini-page Margins, enough that the scaled-down 
margins plus the ClickBook margins exceeds your printer's unprintable region.

Note about some inkjet printers

Many inkjet printers have a larger unprintable region on the bottom edge of the sheet (in Portrait mode, or on the right edge in Landscape 
mode).    If your printer is one of these, adjust the margins enough to compensate for the larger region.    To keep the mini-pages looking 
balanced, increase left and right (or top and bottom) margins equally.



Printing is Clipped at Mini-Page Right Margin        

Problem:    Ends of lines are clipped; that is, not all the text fits before the right margin of each mini-page.

 

Solution:    Before printing the spreadsheet from ClickBook, go to the Options tab and turn on Round Font Size Down.

Explanation 

ClickBook scales down each font of your document to fit the mini-page size, but the precise size needed may not be achievable.      
Normally, it works fine for ClickBook to use the closest possible size.    However, in special cases as described above, making the text 
even very slightly larger than ideal can make some lines too long for the margin settings.

When Round Font Size Down is turned on, ClickBook always uses the precise size needed, or smaller.



Text Within the Mini-Page Gets Clipped            

Problem:    Text is clipped within a mini-page.    This could happen on any superimposed printing that includes text (for example, text on a 
shaded background).    It can also occur where text is too long for its invisible boundaries (as in spreadsheet or table cells).

 

Solution:    Before printing from ClickBook, go to the Options tab and turn on Round Font Size Down.

Explanation 

ClickBook scales down each font of your document to fit the mini-page size, but the precise size needed may not be achievable.      
Normally, it works fine for ClickBook to use the closest possible size.    However, in special cases as described above, making the text 
even very slightly larger than ideal can cause text to get clipped at its boundaries.

When Round Font Size Down is turned on, ClickBook always uses the precise size needed, or smaller.



Mini-Pages are Shifted to the Right or Down            

Problem: In the printout, the mini-pages are shifted to the right or down, while printing is clipped at the right-hand or bottom edge of the 
sheet of paper.

Explanation

This can occur with many applications (for example, WordPerfect and Microsoft Word) when you use a layout with the No Scaling option. 
(The brochure layouts, for example, use No scaling.)    No scaling requires a custom page size to be set in the application program.    But if 
this custom page size does not match the page size of the printer, many application programs handle the mismatch in ways that are 
incompatible with ClickBook. 

 

Solutions

1- If your printer supports custom-sized pages, set the printer's page size to match the page size set in your application program.    (You 
can set printer options using WIndows' Printer Setup.)

2- Otherwise, you need to adjust the effective page size by adjusting the margins in your application program.



Bold Characters are Sloppily Overprinting                

For bold text, it's best to use a font family that includes a true bold font.    (Look in your font list for two fonts with the same name except 
that one is labelled "bold".    An example is the pair "AGaramond" and "AGaramond Bold".) 

If you apply the "bold" attribute in your application program to a font that lacks a true bold font, the bold text may not look good after 
scaling.    (You may get multiple copies of each bold character, not quite superimposed on one another.)

Choosing a true bold font is your best alternative.    Other ways to solve this problem are either not to use bold, or not to use scaling.



Page Numbers in a Table of Content Don’t Line Up            

Problem:    Page numbers on the right in a Table of Contents, which should form a clean, straight right margin, are sometimes not lined up 
after ClickBook scales down the text. 

Solutions 

There are two solutions, the first a work-around, the second a true solution that's a bit more work.

1- Change the format of your Table of Contents, for example, by putting page numbers on the left or immediately after chapter or section 
titles.

2- Turn off scaling in ClickBook.    This requires some reformatting of the document in the application program. 



Underlining Doesn’t Align Correctly         
Problem:    Underlining is shifted a little to the left or right of its correct position. 

Solutions 

There are two solutions, the first a work-around, the second a true solution that's a bit more work.

1- Turn off underlining.    Use italics, capitalization, a different font, or color for emphasis instead.

2- Turn off scaling in ClickBook.    This requires some reformatting of the document in the application program.



Graphics and/or Font Shape Changed When Printed      

Scaling options

 

The three Scaling options on the Modify Layout dialog enable you to control how and whether ClickBook shrinks (scales) the pages of your 
document.    These options are: Stretch to fit, 0ne to one, and No scaling. 

Stretch to fit

Stretch to fit is the scaling setting for most of the ClickBook layouts.    When a layout has Stretch to fit on, ClickBook receives the document 
pages from your application program and scales (shrinks) them as necessary to fit on the layout's mini-page size.      When you use Stretch to 
fit, be sure to set the fonts large enough in the application program to be readable after they're scaled down. 

Preserving the shape of graphics and text 

As ClickBook shrinks the pages of your document down to the mini-page dimensions of the selected layout, the shape of the page may 
change substantially.    In such cases, the shape of the fonts and of graphics may be excessively changed. 

 

To prevent this, select the 0ne to one option on the Modify Layout tab.    ClickBook will then shrink the pages 
proportionately, without altering their shape.    The resulting text or graphics will be somewhat smaller than with 
Stretch to fit, and each mini-page will have some extra white space.

Tip for Side-by-side booklets with 0ne to one

If you print "Side-by-side" booklets using the scaling option 0ne to one, we suggest that you set the page size in your application program 
to Legal Size (8.5 x 14").    Also set the bottom margin to 2".    This creates a page that most nearly fills the mini-page after ClickBook 
scales the pages while preserving shape (aspect ratio). 

Do-it-yourself: The No Scaling option

If you wish to print text and graphics at exactly the size you've prepared them in the application program, select the No scaling option. 
With No scaling on, ClickBook prints one application page on one mini-page without shrinking the data, leaving you to set up the 
application page exactly as you want it to print.

 

This option often solves problems that may occur with scaling.

 

Before printing a document with No scaling, prepare it as follows in the application program:

1- Set fonts to the actual size you want them in the printout.

2- Set the document's page size (in the application program) to match the mini-page size (of the ClickBook layout you plan to use).

 

You must make certain that the document's page size is smaller than or the same as the layout's mini-page size.    Unless you have a reason 
to do otherwise, set the page size to exactly match the mini-page size.    You can set it either by changing the page dimension settings, or 
by changing the margins so that the data area has the desired dimensions.

 

Note:    In some applications it is necessary to use margin settings to accomplish this. 



Data is Messed Up in Printout                                      

If the data is "garbage", most likely the printer driver is incorrect for the printer.      Have you connected a different printer to the port?    
Have you just installed the printer?    To assign the correct driver to the printer, use the Windows Printer Setup. 

Other possibilities are:

1- The driver is an old version.    Get the latest version from your printer manufacturer.    For phone numbers of some major printer 
companies, see... Technical Support 

2- Your printer is low on memory and has made a font substitution.      For solutions to this problem, see... Data is missing from printout



Data is Missing From Printout                                      

Problem:    Data is missing from the printout.    We have seen either scattered characters dropped (with a space printing instead), or whole 
blocks of data missing.    It occurs predominantly in the lower right-hand side of the sheet of paper, on layouts that have multiple mini-
pages per sheet.

 

Explanation A:    Your printer's memory is insufficient for this print job.    Because ClickBook shrinks pages and prints several to a sheet, 
the density of information on each sheet is several times higher than usual.    This requires more memory in the printer, and may exceed 
your printer's limit. 

Solutions

First, to verify that insufficient memory is the problem, check the panel of your printer for error messages, and read its manual. 

Solutions or workarounds for this problem include:

1- Use one of the special low-memory layouts we've provided.    These produce exactly the same final booklets as their normal layout 
counterparts, but print fewer mini-pages per sheet.    They have the words “low mem” in the layout name.

2- If none of the low-memory layouts provided is what you want, make a low-memory version of the layout you prefer.    To do so:

1.    Go to the Modify Layout tab.

2.    Select the layout to be modified.

3.    Turn on Use Absolute Dimensions.    This will prevent the dimensions from changing when you do the next step.

4.    Decrease the number of Mini-Pages on Sheet.    For example, change Down to 1 to print only one row 
of mini-pages.
5.    Save this new version of the layout with a different name, using the Save as button.

3- If you are content to print a larger booklet (or larger mini-pages on a tiled layout), select a layout that has fewer but larger mini-pages. 
For example, if the "Address Book" layout exceeded your printer's memory capability, try one of the "Four-up" layouts.

4- In your application program, edit the document to use fewer fonts and/or graphics.

5- Increase the amount of memory in your printer.

Explanation B:    Alternatively, the problem may be that you have an old version of the printer driver.

 

Solution:    Get the latest version from your printer manufacturer



I Need to Reprint Just Part of My Booklet    

Sometimes you want to print only a part of a booklet, for reasons such as:

1- Before printing the whole booklet, you want to print a sample sheet to see how it looks.

2- A sheet of paper jammed in your printer or came out creased. 

3- After printing, you needed to make a small change that affected just a few pages of your document and did not change the pagination. 

4- Sheet #3 fell on the floor and the dog ate it...

Whatever the reason, you can reprint just the affected sheets, rather than the entire print job.    Here's how: 

Note:    You can print one sheet or a continuous range, but not discontinuous sheets (like 1 and 4).    Of course, with Return to ClickBook 
after printing turned on, you can print one range of sheets now, and then when you return to ClickBook after that printout finishes, you 
can print another range.

1. Prepare for the possibility of reprinting before the booklet finishes printing.    Do this by turning on Return to ClickBook after 
printing. 

 

Before you click Print, you can find Return to ClickBook after printing on the Options dialog.      (If you turn it on there, it stays on for 
future print jobs.)    While the booklet is printing, this option is available in the ClickBook status window.    (If you turn it on there, it stays 
on only for the current print job.)

2. When the printout is finished, ClickBook will reappear .

 

3. Click the Sheet Selection button.

 

4. Specify the range of sheets to be printed by setting First Sheet and Last Sheet. 

You must specify the first and last sheet by number.    An easy way is to display the first sheet you want to print, and then click the button 
that looks like this: First Sheet is thereby set to the number of the currently sheet.      Do the same for Last Sheet.

How to see different parts of the booklet

1- To see the other side of the currently displayed sheet, use the Front and Back buttons.

2- To switch between viewing a single mini-page and a whole sheet, click on the picture.

3- To navigate to various sheets of the booklet, use the bar beneath the picture:

Go to the next or previous sheet by clicking the arrow button on the left or right side of the bar.

Go to any specific sheet by dragging the slider button left or right.    Release the mouse button when you see the desired sheet 
number.

5. Choose the desired option for printing fronts and/or backs of the sheets.    Also choose whether or not to print the instruction sheet.

 

6. Click Print to begin printing. displayed 



Letter-Sized Paper is Not My Standard                
ClickBook is originally set with a default paper size of 8.5" x 11" (Letter size).    If you usually use paper of a 
different size, reset the default.    It's on the Options dialog.

Note: To reset the paper size just for a particular booklet, send the document to ClickBook.    When ClickBook pops up (but before you 
click Print), go to the Modify Layout dialog and set Paper Size.    Before leaving that tab, click the Save As button and give the layout a 
new name.    (You might want to use the document name, or the current layout name plus the paper size.)      The Paper Size setting, like all 
settings on the Modify Layout tab, is stored in the layout and used for all booklets you print with that layout.



Thick Folded Books Have Uneven Edges and Margins

Problem:    Thick folded books have uneven page edges, or if you trim the edges, then the margins get progressively smaller toward the 
inside pages.    (These problems are known as shingling and margin creep.) 

 

Solution #1: 

Use sub-booklets to print the booklet in several parts, and then bind these together.    Small sub-booklets have minimal shingling.

Solution #2:

Select the cut-book version of the layout for your document.    Or, if none exists, modify the layout by changing its Booklet Style to Cut 
book. 

 

After printing the book, you'll need to make one more cut than for a folded book.    Then you can bind it, for example, by punching holes 
and using a ring binder or spiral binding. 



I Can’t Print Double-Sided, But I Want Double-Sided Booklets    

If you cannot print double-sided, or prefer not to, you can print single-sided and then photocopy the printout as double-sided.      In a single-
sided printout, the "front" and "back" sides alternate: the first front sheet prints first, then the first back sheet, then the second front sheet, 
and so on.    You can put the stack in a photocopier that performs single-sided to double-sided copying, and the resulting copy will be ready 
for folding, cutting, and assembling.
 

This a good option if:

1- You use a network printer and cannot get exclusive access to it in order to print the second side.

2- The second side "bleeds through".    You may wish to take your single-sided printout to a professional copy/print shop.

3- Your printer doesn't feed the sheets well on the second printing pass.

4- You have a continuous feed (e.g. tractor feed) printer, and thus printing double-sided is a hassle.

5- You want lots of copies anyway, and single-sided to double-sided copying is easier for you than double-sided printing.

 

To print single-sided:

1. Go to the Modify Layout dialog.

2. Select the layout you wish to use.

3. Turn on the Single-sided option.

4. Save the modified layout with a new name, using the Save As button.

5. Press the Done button and begin printing.



How Can I Print Double-Sided on a Shared Network Printer            

Printing double-sided on a printer shared with other users is tricky, because after reloading the first-side printout into the paper tray, you 
must assure that your second-side print job will be the next one to arrive at the printer.    Note: duplexing printers are the optimal solution to 
this problem.    They handle back and front sides in a single print job.    So if you are using a duplexing printer, you can ignore this Help 
topic. 
 

You must get a "lock" on the printer before reinserting the first-side stack.    You can do this through your network software, or in any way 
that guarantees no other print job will come through before yours, such as printing when no one else is using the printer.

 

Some network software prints or ejects an extra sheet before each print job.    If yours does this, remove this extraneous sheet before 
reinserting the printout stack for printing the second side.    And then place a blank sheet of paper on top of the stack before starting to print.

 

An easier way

For many users, an easier approach is to print single-sided from ClickBook, and then produce double-sided output from a photocopier.    
ClickBook's single-sided layouts are expressly designed for this purpose.    See… I can't print double-sided, but I want double-sided 
booklets



Paper Jams in the Printer                                                        

If paper frequently jams in your printer, or curls excessively:

1- If you are using the manual (or special-purpose) paper tray to reinsert the printout before printing the second side, try using the lower 
tray instead.    (Or vice versa.)    You will need to run ClickBook's Custom Printer Setup again using this method if the second sides don't 
print correctly at first.

2- Check your printer manual for recommendations, or check with the vendor.    There may be helpful recommendations of paper weight, 
fanning the paper before loading it, a setting to change the paper exit path, etc.

3- Also, experiment with different papers.    Two different brands or types of paper may perform differently even though they are of the 
same weight. 



The Second Side of the Paper Wasn’t Printed        

Problem:    I printed my document into ClickBook and it printed all the pages on one side of the paper and I wanted it to print on both sides.

Explanation A:

When you setup your printer to work with ClickBook it asked you,    “ClickBook has detected that the printer driver used with this printer 
can duplex (print on both sides of the paper without user intervention).    Some printer drivers do not accurately report the printer's 
capabilities.    Do you want ClickBook to use the duplex setting?”

If you press the yes button and your printer cannot duplex on it own without user input then ClickBook will send all the pages to the printer 
and not pause to allow you to reinsert the pages to print on the other side of the paper. 

Solution: 

Setup your printer again to work with ClickBook and make sure you press the No button when ClickBook asks if your printer can duplex. 
You can do this by launching ClickBook and click the File->ClickBook Printer Setup… menu item.

Explanation B:

You are using a layout that can only print on one side.    An example is the Fax layout. 

Solution:

Select a different layout that is double sided.    An easy way to check for this is to look at the Back button.    If it is disabled then the layout 
is single sided.    Otherwise the layout is double sided. 

Explanation C:

You changed the layout from double sided to single sided, maybe by accident. 

Solution:

1. Launch ClickBook
2. Click the Layouts->Modify Layout… menu item. This will launch the Modify Layout dialog.
3. Select the layout you want to modify.
4. Look for “Print Sides:” under the binding controls and change it from “Single Sided” to “Double Sided”.
5. Click the “Save As…” or “Done” button to save the changes to the layout.



Header or Footer Doesn’t Print On All of the Pages                     
ClickBook defines a non-printable area where information can not be printed. If your header and footer do not appear on each 
page try adjusting the mini-page margins to compensate for the space needed to print your headers and footers. 

1. Select Modify Layout from the Layout menu

2. Under Mini-page margins change the Top/Bottom to ".50" for side-by-side layouts. (smaller layouts will have smaller 
margins)



Headers/Footers/Watermarks Do Not Appear On My Printout    
Some programs use a white or colored background instead of an invisible background. 

1. You can look inside the program you are using to see if there is an option available to change the background to clear. If the 
background is clear then your headers, footers, and watermarks will print out. If you can't adjust the background try adjusting 
the mini-page margins to compensate for the space needed to print your headers and footers.

or 

2. Select Modify Layout from the Layout menu, and under Mini-page margins change the Top/Bottom to ".50". There currently 
isn't a work-around for Watermarks.
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Customer Support  

Blue Squirrel Software offers several technical support services to assist you.

Customer Service

ü For a quick response, send an email to: sales@bluesquirrel.com

ü Contact us by phone by calling : 800-403-0925

Technical Support

ü The first line of support should be this Help file.

ü If you cannot find the information you need here, contact us at our Web site.    All of the online help options and frequently 
asked questions (FAQs), are detailed on our Customer Support home page at: 
http://www.bluesquirrel.com/support/supportSystem.html

ü For a quick response, email our support staff: support@bluesquirrel.com

ü Contact us by phone by calling : 801-523-1065



System Requirements                                                                            

In order for ClickBook to install and run properly, the following are required:

q Pentium 100 or faster machine

q Windows 9X/NT

q  16 Megabytes of RAM

q 10 Megabytes of free disk space on your hard drive.



      Easier-to-use User Interface
You'll find ClickBook's new interface very easy to use because it offers a Windows 98 look and feel.

______________

See also…

ClickBook  ’  s Main Window   



      Wizards
ClickBook offers a Layout Creation Wizard , and a Custom Printer Setup Wizard . Both of which are very intuitive and will guide 
you through the steps to setup your printer(s), and customize a layout to meet your needs.

_______________

See also…

Layout Creation Wizard 

Custom Printer Setup Wizard 



      Improved PDF printing
ClickBook is now compatible with Adobe Acrobat 4.0!



      Combine Landscape & Portrait documents
Now you can combine both orientations into one print job, and print both ways in 1 print job. In ClickBook 2.2 you could combine 
them in a print job together, but ClickBook would only print in 1 orientation, either Landscape or Portrait.      To combine 
landscape and portrait just set the scaling on one-to-one.



      Table of Contents
You can elect to have ClickBook add a Table of Contents to your print job, which lists all of your print jobs (up to 31 print jobs), 
and the page numbers that each print job starts on.

_______________

See also…

Add a Table of Contents 



      Page Numbers
ClickBook gives you the ability to add page numbers to your print job, and will place the number in the bottom/center position of 
each page.

_______________

See also…

Add Page Numbers 



      Borders
You can choose to add borders to your print jobs, which include dashes, lines and frames. You can also elect the thickness of the 
borders such as, small, medium and large.

_______________

Add Borders 



      Temporary layout formatting
You can temporarily change the settings in ClickBook to easily customize your print job(s).    You can add borders, page 
numbers, change the scaling and print double-sided.



      Easy Access to ClickBook files
You can easily access the last 4 CB. files that you've opened or saved from ClickBook's File menu.



      More Layouts
We've added NEW Day Planner layouts!



      Exchange Layouts
From the ClickBook Community, www.clickbook.com, you can submit, and find new layouts from other users around the globe!



      Drag and Drop
Once you've created a shortcut on your desktop or on your Windows task bar to a ClickBook or CB Printer you can easily select 
files, and drag and drop them onto the ClickBook or CB Printer icon. Then ClickBook will automatically launch the program the 
file was created in, and print the file to ClickBook. This is a great way to speed up the printing process. Please note, in order to 
create a shortcut on your Windows Taskbar you must have version I.E. 4.0 or later.



      Instant Printing
1 Step Printing - You can setup ClickBook so that it automatically starts the printing process when you elect to print from a 
program (No ClickBook program intervention). If you've already printed a document once, and print it again using ClickBook it will 
use the same layout settings previously, such as, double-sided portrait to print the job. If you elect to print a different document 
ClickBook refers to the default layout settings, which is double-sided booklet to print the job. 



      Control for each printer
Now you can setup customized settings for each printer. Prior to ClickBook your printer setup settings were global, and now you 
can customize settings to tailor each printer.



      InstantX

The Purchase/VIP Key tab require you to fill out the requested information about the user and gives you the option to purchase 
ClickBook online or to print the information to send.    This is also the screen to enter the VIP Key to fully enable ClickBook once 
it has been purchased.



 Menu Bar
The Menu Bar offers access to commands organized into menus. 

_______________

For more information see…

Menu Options 



 Tool Bar
The Toolbar offers one click access to the most commonly used commands. 

_______________

 For more information see…

 Toolbar Options 



 Print Jobs Bar
The Print Jobs Bar informs the    user which printer the application will print to, how many pages were received from the 
application program and allows the user the ability to delete a print job. 

_______________

For more information see… 

Print Jobs Bar.



 Print Preview Window
The Print Preview Layouts window allows the user to select different layouts and preview their project before they print. 

_______________

For more information see…

Print Preview.



 Open
Opens an already existing .cb2 file.    The Open File dialog box appears.



 Save
Saves the active print subject to a .cb2 file.



 Save As
Saves the active print subject to a .cb2 file named by the user.



 Print
Prints the current project(s).



 ClickBook Printer Setup
Use this option to verify ClickBook printer information, or change the configuration.    The ClickBook Printer Setup dialog box 
appears.



 Recent File
This area displays recently used files.    If the user selects one of these files ClickBook automatically opens the file.



 New
Clears all of the open projects from ClickBook.



 Exit
Closes ClickBook.



 Layout Wizard
The Layout Wizard is a simple way to make and modify layouts the way the user wants.



 Modify Layout
Modify Layout takes you to a single screen where the user can make any changes necessary for any layout. 

Note:    These changes are permanent for which ever layout is modified.



 Set Default Layouts
Allows the user to set the layout that ClickBook will open with.    For more information see...Setting the Default Layout.



 Check Box
This allows the user to turn on and of the bars preferred.



 Status Bar
The Status Bar lists the action of the current highlighted option.



 Toolbar
Displays the Toolbar.



 Text Labels
Turns on and off the text on the Toolbar.



 Print Job Bar
Displays the Print Jobs Bar.



 Options
Brings up the Options dialog box and allows the user to make changes to print settings, program settings and paper and border 
settings.



 Temporary Job Settings
Brings up the Temporary Job Settings dialog box.



 Update Now!!!
Select this option to launch InstantX to automatically download any ClickBook updates to which you are entitled.



 Undo Last Update
Select Undo Last Update...to revert back to your previously installed version of ClickBook.



 Settings
Select Settings to view your InstantX settings.    The InstantX dialog box appears.



 Help Topics
This option launches the ClickBook help file.    Use this file to learn how to use ClickBook, or to answer specific questions on 
ClickBook functions.



 ClickBook Homepage
This option launches your browser to the ClickBook Home page, http://www.clickbook.com.



 License Agreement
This option displays the ClickBook license agreement.



 Register
This option brings up the ClickBook registration form.    Enter your registration information and register on-line.



 About ClickBook
This option displays version and copyright information about ClickBook.



 Open File dialog box
Opens an existing file.    The Open File dialog box appears.



 Options dialog box
Brings up the Options box where you can make changes to the print settings, the program settings, paper size and borders.



 Temporary job settings dialog box
Brings up the temporary job settings dialog box, where you can make changes that only apply to the current print job.



  Print Status
The Print Status informs the user which printer is going to be used and how many pages were received from the application 
program.



  Print Jobs
Print Jobs shows which applications are going to be printed and allows the user to remove unwanted applications.



  Num of Copies
Allows the user to increase or decrease the number of copies that will be printed.



  Front/Back
Allows the user to view the Front or the Back in the Print Preview.



  Sheet Selection button
Allows the user the option to print just the front, back or both pages of a document.    Sheet Selection also allows the user the 
option of what page to start printing from and what page to end on.    Users can also select whether they want the Instruction 
Sheet printed also.



  Print Preview
Shows the user what their documents would look like with whatever layout they choose.



  Layout Type
The Layout Type gives the option of what type of layout the user wants to use.



  Specific Layouts
Allows the user to select any layout they want to use.



  Print Instruction sheet
Gives the option to print the instruction sheet or not.



  Print Front Back
Allows the user to print just the Front, Back or both sides of a document.



  First Last
Allows the user to select what page the print job begins and ends.



  Insert Blank Page
This will place a blank page in your print jobs.



 Insert Blank Page
This button will place a blank page in your Print Job.



 Printer Status
Displays what printer ClickBook is going to print to.



 Pages Recieved
Displays all pages recieved from the application program.



 Check Boxes
Allows the user to pick which documents are to be printed.



 Print Job

Displays the names of all documents in print job.



 Number of pages
Displays the number of pages in each document.



 Next
This button allows the user to get to the next step.



 Back
This button allows the user to get to the previous step.



 Cancel
This button allows the user to cancel all changes and leave that screen.



 Layout Graphic
This allows the user to view what their layout looks like.



 Categories
This drop down menu allows the user to select what type of layout they would like to use.



 Layouts
This drop down menu allows the user to select the specific layout they would like to use.



 Booklet Type
This drop down menu allows the user to select whether they want a Cut Book, Folded Book, French Fold, Planner Pages, Tiled, 
or Tri-fold booklet.



 Sheet Orientation
Sheet orientation allows the user to select whether they want their sheet Landscape (Horizontal) or Portrait (Vertical).



 Mini-Pages
This allows the user to select how many pages they want per sheet of paper.



 Paper Size
Allows the user to choose what size of paper to use.



 Binding Edge
Allows the user to select how they want the binding edge.



 Print Sides
Allows the user to select whether to print on onse side or bothe sides of the paper.



 Sub Booklets
This allows the user to break down big print jobs into sub booklets every selected amount of pages.



 Absolute Dimension
This allows the user to change the exact height and width of the mini-pages.



 Scaling
This allows the user to select whether they want Stretch to fit, One to one, or No scaling.



 Paper Margins
Allows the user to change the margins of a sheet of paper.



 Mini-page Margins
Allows the user to change the margins of the mini-pages.



 Change Icon
This allows the user to select an icon to represent this layout.



 Save As...
This button allows the user to save their changes as a new layout.



 Done
This button allows the user to save their changes over an existing layout.



 Abandon Changes
This button allows the user to erase all changes they made.



 Easy Printer Setup
This button brings up a dialog box for the user to select which printer to set up.



 Custom Printer Setup Wizard
This button brings up a wizard to help the user set up their printer.



 Printer Settings
This button allows the user to change the settings for their printer.



 Printer to Setup
This allows the user to select which printer to set up as a ClickBook Printer.



 Printers that have been setup
This window displays which printers have already been set up to print from ClickBook.



 Close
This button closes ClickBook Printer Setup



 OK
This button saves the settings and exits the current screen.



 Printer Being Setup
This box displays which printer is currently being setup.



 Has the same paper path as
This window displays which printer path is being setup.



 Paper Path
The printers that ClickBook has paper paths for.



 I have the pages
By clicking on this button you will move to the next step.



 Printed
Takes the user to the next step.



 Printer is Ready
By clicking on this button the user is confirming that the printer is ready to print and to move on to the next step.



 Duplex Settings
The Duplex Settings allows the user to select whether their printer has automatic duplexing and the printer changes sides of the 
paper.



 Printer Corrections
This allows the user to make corrections that their printer cannot accomplish.



 Properties
Properties allows the user to change the properties of their printer and view important information.



       Set Default Layouts 
Allows the user to change and set the layouts they want as the default each time ClickBook is opened.

 



 Portrait
Displays the layout specified if portrait is default.



 Landscape
Displays the layout specified if landscape is default.



 Set Default Layout
Saves changes made and sets layout as default.



 Done Button
Closes the current window.



  Program Settings 
This tab allows the user to make changes to ClickBook.

 



  Print Settings
This tab allows the user to make changes to what is printed.



 Instant Printing
Instant Printing allows the user to print a document through ClickBook without opening ClickBook.



 Return to ClickBook 
This returns the user to ClickBook after a print job is finished.



 Show document orientation warnings
This will inform the user that there may be problems with the document orientation.



 Show layout orientation warnings
This will inform the user that there may be problems with the layout orientation.



  Paper Borders 
This will inform the user that there may be problems with the document orientation.



 Default paper size
This allows the user to select what size of paper is set to the default.



 Layout unit size
This allows the user to select the default unit used in layouts.



 Border types
This allows the user to select a default border.



 Thickness
This allows the user the option to select the thickness of a border.



 Temporary Borders
This allows the user to select a border to add for the current print job.



 Temporary Thickness
This allows the user to select a thickness for the borders of the current print job.



 Temporary Scaling
This allows the user to select how the text scales the layout of the current print job.



 Temporary Page Separator
This allows the user to add a number of blank pages to the current print job.



 Temporary Double Sided
This allows the user to print the current print job on both sides of the page.



 Temporary Page Numbers
This allows the user to add page numbers to the current print job.



 Default
This reverts back to the default settings for the current layout.



  Status Bar
The Status Bar informs the user what each item does just by passing the cursor over it.



  ClickBook Printer Setup dialog box                

ClickBook Printer Setup allows the user to setup or verify ClickBook printer information, and change the configuration.

5. Click on OK.



  Add Page Numbers  

To add page numbers to your print job:

1.          Click on the options button  on the toolbar.    This will bring up the Options dialog box.

2.          Put a check in the box entitled Print Page Numbers.

3. Click on OK.    Page numbers will now be placed at the bottom of your print job.



 Selected Sheets
This allows the user the option of what page to start printing from and what page to end on.



 Instruction Sheet
This allows the user to select whether they want the Instruction Sheet printed also.



 Both Sides
This allows the user the option to print just the front, back or both pages of a document. 

 



 Print cut marks
Prints the marks on which the cuts need to be made to create the booklet properly.



 Print second side instructions
Prints the instruction on how to print the other side of the page.



 Print assembly Instructions
Prints the instructions on how to assemble the booklet correctly.



 Print info sheet
Prints useful information about ClickBook, the document, the print job, the printer, and the template.



 Printing a range of sheets 

Sometimes you want to print only a part of a booklet, for reasons such as:

¨ ¨ Before printing the whole booklet, you want to print a sample sheet to see how it looks.

¨ ¨ A sheet of paper jammed in your printer or came out creased.

¨ ¨ After printing, you needed to make a small change that affected just a few pages of your document and did not change 
the pagination.

¨ ¨ Sheet #3 fell on the floor and the dog ate it…

Whatever the reason, you can reprint just the affected sheets, rather than the entire print job.    Here’s how:

Note: You can print one sheet or a continuous range, but not discontinuous sheets (like 1 and 4).    Of course, with Return to 
ClickBook after printing turned on, you can print one range of sheets now, and then when you return to ClickBook after that 
printout finishes, you can print another range.

6. 6. Prepare for the possibility of reprinting before the booklet finishes printing.    Do this by turning on Return to ClickBook 
after printing.

Before you click Print, you can find Return to ClickBook after printing on the Program Settings Tab in Options.    If you turn it 
on there, it stays on for future print jobs.    While the booklet is printing, Return to ClickBook after printing is available in the 
ClickBook status window.    If you turn it on there, it stays on only for the current print job.

7. 7. When the printout is finished, ClickBook will return.

8. 8. Click the Sheet Selection button.

9. 9. Specify the range of sheets to be printed by setting First Sheet and Last Sheet.    You must specify the first and last 
sheet by number. 

How to see different parts of the booklet

¨ ¨ To see the other side of the currently displayed sheet, use the Front Back buttons.

¨ ¨ To switch between viewing a single mini-page and a whole sheet, click on the picture.

¨ ¨ To navigate to various sheets of the booklet, use the bar beneath the picture: 

¨ ¨ To go to the first or last sheet, click the arrow button at the left end or right end of the bar.

¨ ¨ To go to the next previous sheet, drag the slider button left or right.    When the desired sheet number is 
shown, release the mouse button.

¨ ¨ To go to the next or previous sheet click the bar on the left or right side of the slider, depending upon which 
way you want to go.

10. 10. Choose the desired option for printing fronts and/or backs of the sheets.    Also choose whether or not to print the 
instruction sheet.

6.          Click Print to begin printing.



 Wizard
A Wizard is a guide to help you understand all of the steps of a process in ClickBook.    The two wizards in ClickBook are the 
Custom Printer Setup Wizard and the Layout Wizard . 



 Tri-fold
One of the Booklet Style settings (in Modify Layout).    The Tri-fold setting is for a single sheet that you will fold twice to make a 
three panel brochure.



 Toolbar
The ClickBook Toolbar, which is found on the main screen,    offers one click access to frequently used commands. 



 Tiled
One of the Booklet Style settings (on the Modify Layout dialog).    Tiled layouts are designed for printing multiple pages on a 
sheet but not cutting the sheets.    The sheets that come out of the printer are the final sheets. 



 Temporary Job Settings
The Temporary Job Settings allows you to make changes that apply only to the current print job.    This will not affect the 
permanent default settings.    Some of the changes you are allowed to make include:

Scaling, Borders, Page Numbers, and double sided.



 Table of Contents
A Table of Contents can be added to any print job.    This will allow you to see what documents you printed and to find them 
easily in your booklet.    The Table of Contents can be enabled by clicking on the Options button and selecting Print a Table of 
Contents Page.



 Surf-n-Print
Surf-n-Print is a    category of layouts that is best used for printing Web pages. 



 Sub Booklet
One of several smaller booklets that you bind together to make a booklet.    Using sub-booklets is useful for reducing "shingling", 
or for creating personalized booklets with your application's mail-merge feature.



 Status Bar
By passing the cursor over the screen the Status Bar informs the user what each button on the everything is used for does .



 Standalone Mode
When you start ClickBook without sending a document to it, this is "standalone mode".    From standalone mode you can set up a 
printer for use with ClickBook, create or modify layouts, change various ClickBook settings, etc., but you cannot print a document 
unless you open a .cb2 file.



 Shingling
The problem that the page edges of a thick folded book don't align, because pages farther out (toward the covers) have to 'wrap 
around' the thickness of the inner pages.



 Sheet Selection
Feature that allows you to specify a range of sheets to print, rather than the whole booklet.



 Sheet
A genuine wood-pulp piece of paper, on which ClickBook may print several mini-pages.



 Second-side instructions
An instruction sheet printed with the first side of a double-sided printout, which tells you how to reinsert the paper into the printer 
before printing the second side.    A global setting in Options on the Print Settings tab lets you stop printing these instructions.



 Scaling
Shrinking or enlarging of an image or font.      ClickBook offers three scaling options: Stretch to fit, One to one, and No scaling.



 Repeat
Feature, in Modify Layout, that fills the paper sheet with identical mini-sheets.    This has several uses.



 Readme
A file in your ClickBook directory that contains updated information not found in the ClickBook manual.    readme.rtf can be 
printed automatically at the end of the Setup (installation) program, or you can print it later, at your convenience.    You can read 
or print readme.rtf from Microsoft Word.



 Printing Mode
ClickBook's state of readiness to print a booklet.    ClickBook is in printing mode when you have printed a document to it from an 
application, or have opened a .cb2 file.    From printing mode you can print a booklet, save or open a .cb2 file, modify layouts, 
etc. -- any ClickBook task except setting up a printer, which you must do in standalone mode.



 Printer Setup
Procedure for creating the special ClickBook version of a printer's driver, with information that is necessary for printing double-
sided printouts correctly on that printer.    Composed of the Easy Printer Setup and the Custom Printer Setup.    Easy Printer 
Setup creates the printer driver instantly for printers ClickBook is already familiar with.    For other printers you need to run 
Custom Printer Setup, a printing exercise that reveals the necessary details about the printer.



 Print Preview
Feature that allows you to view a computer-drawn approximation of how your document will be printed with the current layout 
specifications.    With this feature you can view changes you have made to a layout, before actually printing.



 Print Job Bar
This feature gives information that applies to the current print job, such as: which printer the print job is going to, how many 
pages it received from the application program, what print jobs are ready to print,    and allows you to delete unwanted print jobs.



 Portrait
Orientation of a page so that it is taller than it is wide.    For example, standard letter-sized paper, when in portrait orientation, is 
8.5" wide by 11" tall.



 Planner Pages
A category of layouts is designed for day planner laser paper that has holes on the left and right hand side. 



 Page Separator
Feature designed so you can have a blank page or pages before, after or between documents in a print job. 



 Page Numbers
Feature that allows you to place page numbers on every page to make it easier to find what you are looking for.



 Orientation
Either of two distinct settings:

¨ ¨ The landscape/portrait setting of your document's pages in its application program.

¨ ¨ ClickBook's sheet orientation.
¨ ¨



 Mini-page Size
Controlled by several settings in Modify Layout.    You can define the size of each mini-page by specifying either:

¨ ¨ How many pages to print Across and Down the page.

¨ ¨ The Absolute Width and Height of each mini-page.
¨ ¨



 Mini-page
ClickBook receives the pages of your document from the application program and then shrinks them (for most layouts) and 
arranges them on the sheets of paper.    The resulting booklet pages are called "mini-pages".    These pages contain the same 
data as they did in the application program, but the are usually smaller then a sheet of paper.



 Menu Bar
The Menu Bar offers access to commands which are organized into menus. 



 Margin Creep
The problem of margins getting prograssively smaller toward the inside pages after you have trimmed the uneven edges of a 
thick folded book.



 Layout
A detailed specification of your printout, composed of all the settings on the Modify Layout dialog box.



 Landscape
Orientation of a page so that it's wider than it is tall.    For example, standard letter-sized paper, when in landscaper orientation, is 
11" wide by 8.5" tall.



 Instruction Sheet
A page printed with your with your print job that has information on how to assemble the booklet.



 Instant Printing
Printing a document from the application program through ClickBook, without opening it, and straight to the printer.    Instant 
printing prints the document in the default layout of ClickBook.



 Information Sheet
A page of orientation that you can print with your print job that has all the information about the settings.



 Global Settings
Settings that apply to all ClickBook printouts, not just a specific layout.



 French Fold
The Booklet Style setting for greeting cards made by folding the printed sheet in fourths.



 Folded Book
One of the Booklet Style settings.    To make a folded book you fold between facing pages.    Most likely, the binding method will 
be stapling.



 Flip
The binding orientation for a book whose binding will be on the top edge, with pages    turned by flipping up.



 First/Second Side
We call the two print jobs involved in a double-sided printout the “first side” and “second side” because “front” and “back” are 
not very meaningful for many ClickBook printouts.    For example, one side may contain both the front and the back covers of a 
book.



 Element
Any component of ClickBook you can use, including list boxes, text or number boxes, buttons, check boxes, and so on.



 Duplexing Printer
A printer that will print on both sides of a paper without you having to touch the page.



 Driver, Printer
A program that knows how to print correctly to a specific printer model. Setting up a printer for a program means making a driver 
for it available. 



 Defining Document
The first of several documents you send to ClickBook as one booklet.    The defining document's printer, resolution page 
orientation, and page width and height are used for all documents of the booklet.    Even if you later change the order of the 
documents -- or even delete the defining document -- the settings from the document you sent to ClickBook first are still used for 
the whole booklet.



 Cut Marks
Small lines or dashed lines on the first sheet of your printout that show where are in what order to cut.    The single dash 
indicates the first cut, a double-dash indicates the second, a series of three dashes indicates the third, and so on.



 Cut Book
One of the Booklet Style settings.    A cut book has a cut edge between the facing pages (at the spine) so that the binding is 
applied to cut papaer edges.    Any folded book layout can be converted to a cut book layout by changing its Booklet Style in 
Modify Layout.



 ClickBook
The program you are using and a registered trademark of Blue Squirrel.



 .cb2 File
A ClickBook booklet file.    Consists of all the documents you saved together as a booklet.    Enables you to print the booklet again 
without having to print all the documents from their application programs again.



 Categories
Areas in which layouts are placed according to their specifications. 



 Booklet Style
The format of your final product after printing with ClickBook and then cutting, assembling, folding, and/or binding.    Every layout 
has a booklet style setting.    The arrangement and order of the mini-pages on the printout differs according to this setting.



 Booklet
A booklet is the final product after printing with ClickBook and then cutting, assembling, folding and/or binding. 



 Application Program
The application program (word processor, spreadsheet, etc.) where you prepared the document and started printing.



 Absolute Dimensions
Mini-pages Width and Height that you specify in order to match a custom page size.    Usually, ClickBook sets the mini-page 
dimensions so that they will fill the sheet of paper (based on the number of mini-pages Across and Down).    But you can set the 
dimensions by Turning on Use Absolute Dimensions first.    These settings are in Modify Layout, under Layouts on the menu bar.



Repeat button
Repeat can be used to print more copies when there aren’t enough mini-pages to fill the sheet.      Repeat can also be used, 
alternatively, to avoid the step of assembling multiple booklets.




